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What this exercise is about
The objective of this lab is to provide you with an understanding of WebSphere Adapter for Flat Files and
inbound event processing. In this lab you will deploy the WebSphere Adapter for Flat Files, using

WebSphere Integration Developer, and integrate it with an SCA application that polls for inbound events
and processes those inbound requests from the file system.

Lab requirements
List of system and software required for the student to complete the lab.
e WebSphere Integration Developer V6.2 installed and updated with latest fixes
e WebSphere Process Server V6.2 Test Environment installed and updated latest fixes

e Extract Labfiles62.zip to your C:\ (your root) drive

What you should be able to do
At the end of this lab you should be able to:
< Import Flat File adapter RAR file into WebSphere Integration Developer
e Use External Service wizard to configure Activation Spec Properties, Resource Adapter Properties to
Eizr;%rlztrz Business Objects and other artifacts and configure Function Selector, Data Binding and Data

« Deploy the adapter application onto WebSphere Process Server

e Test the deployed application using WebSphere Process Server test environment for both pass-
through and non pass-through using different scenarios and patterns

e Restore the server configuration

Introduction

The backend EIS is the source of events. When events are generated at the EIS, files are created by the
EIS in the file system at a specific directory location, which needs to be configured as the Event Directory
for the adapter.

The adapter polls event files from the multiple Event Directories periodically based on user-configured
Event File Mask, Poll Quantity and Poll Period. Each file will form a fundamental unit of transfer to the
adapter which can internally represent more than one backend events. The adapter sends the entire file
content across to the endpoint in the form of a Business Object for further processing.
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The event management framework takes care of delivering the event only once to the endpoint. FF RA
(Flat File Resource Adapter) internally uses an event table to log the status of the events that have been
polled but not yet posted to the endpoint. Once an event is polled, the FF RA generates the Event ID and
stores the event reference in the event table with a NEW status. The base class functions call the adapter
methods to process the events. The FF RA changes the status for the event in the Flat Files event table to
an IN_PROGRESS status. It wraps the file content in a Record and posts the same across to the
configured endpoint.
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Once the event BO is posted, the event entry is then deleted from the event table. After the Business
Objects are sent out of the adapter, the events are archived optionally, in a user-configured Archive
Directory on the file system.

Exercise instructions

Some instructions in this lab are Windows operating-system specific. If you plan on running the lab on an
operating-system other than Windows, you will need to run the appropriate commands, and use
appropriate files ( .sh or .bat) for your operating system. The directory locations are specified in the lab
instructions using symbolic references, as follows:

<WID_HOME> C:\Program Files\IBM\WID62

<WPS_HOME> C:\<WID_HOME>\runtimes\bi_v62

<FFADAPTER_HOME> | <WID_HOME>\ResourceAdapters\FlatFile_6.2.0.0\deploy

<LAB_FILES> C:\Labfiles62 /tmp/Labfiles62
<WORKSPACE> <LAB_FILES>\FlatFileInbound\workspace

<EVENT_DIR> <LAB_FILES>\FlatFilelnbound\eventdir

<ARCHIVE_DIR> <LAB_FILES>\FlatFilelInbound\archivedir

<FFFILES> <LAB_FILES>\FFFiles

<TEMP> C:\temp ftmp

Windows users note: When directory locations are passed as parameters to a Java™ program such as
EJBdeploy or wsadmin, it is necessary to replace the backslashes with forward slashes to follow the Java
convention. For example, replace C:\Labfiles62\ with C:/Labfiles62/
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Instructions if using a remote server for testing

Note that the previous table is relative to where you are running WebSphere Integration Developer. The
following table is related to where you are running the remote test environment:

<SERVER_NAME> serverl sssr011

<WAS_HOME> C:\Program letc/sscell/AppServer
Files\IBM\WebSphere\AppServer

<HOSTNAME> localhost mvsxxx.rtp.raleigh.ibm.com

<SOAP_PORT> 8880 8880

<TELNET_PORT> N/A 1023

<PROFILE_NAME> AppSrvol default

<USERID> N/A ssadmin

<PASSWORD> N/A frlday

Instructions for using a remote testing environment, such as z/OS, AIX or Solaris, can be found at the end
of this document, in the section “Task: Adding remote server to WebSphere Integration Developer
test environment”.
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Part 1: Initialize the workspace and prepare for the lab

This part of the lab, you will start the WebSphere Integration Developer V6.2 with a new workspace and
create required data source and database using the administrative console of WebSphere Process Server

V6.1

1. Extract the provided Labfiles62.zip to your C:\ (root) drive, if you have not already done so. This will
create the necessary subdirectory structure to complete the lab, and provides you with sample text

files

2. Start the WebSphere Integration Developer V6.2 with a new workspace

__a. Select Start > All Programs > IBM WebSphere Integration Developer > IBM WebSphere
Integration Developer V6.2 > WebSphere Integration Developer V6.2

___b. From the Workspace Launcher window, enter <WORKSPACE> for the Workspace field

= Workspace Launcher |

Select a workspace

IEM WehbSphere Integration Developer 6.2 stores your projects in a folder called a workspace.
—hoose a workspace Folder to use For this session,

Warkspace: IC:'I,LaI:uFiIesEuE'I,FIaI:FiIeInI:u:-unu:I'l,w-:urkspa-:e

} Copy Settings

7 (a4 Zancel

e . .
3. Click the =~ button on the right corner to close the Welcome page and proceed with the
workbench

4. Follow the instructions of ‘WPBMv62_ConfigureDatasourceTask’ lab with these inputs and create
the data source and data base required for this lab:

___a. Data source name: FF
__ b. JNDI name: jdbc/FF

___c. Database name: FFDB
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Part 2: Pass through scenario

Inbound support can be broadly classified into two flows, one that involves data transformation and
another without it (pass-through). In this part of the lab, you will configure the pass through scenario using
the new External Service option from the WebSphere Integration Developer and then test the
configuration.

Pass through flow for the inbound scenario:

ActivationSpec properties _ _
RA emits FlatFileUnstructuredRecord instance containing.

- Palis e raw binary data for event.

Since data handler property is null, FS
instantiates UnstructuredContent

(]
L]
i
"
L
L]
L]

FlatFilaRs ==

< Event data is picked from the event file based on event file size and SplitCriteria, converted into a
byte[] and set as a ByteArraylnputStream on FlatFilelnputStreamRecord.

e Protocol specific information like event file name, directory name are also set in the
FlatFilelnputStreamRecord.

e The FlatFileInputStreamRecord is sent to the Function Selector. The Function Selector instantiates the
wrapper. There is no value for the data handler property in the chose databinding, so no content-
specific data handler is invoked but UnstructuredContent SDO is instantiated. It is set with byte
content.

e The FlatFile wrapper is set with protocol specific information and UnstructuredContent is set in FlatFile

» FlatFile wrapper data object is set in FlatFileBG and sent to the endpoint.
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2.1. Configure pass through using the external service wizard

In this part of the lab you will use the new external service feature to create and configure the function
selector, data binding and other required artifacts to test the inbound pass through scenario

1. Create the module: FFPSInboundModule
___a. From the Business Integration window, right-click and select New > Module
___b. From the New Module window, enter FFPSInboundModule for the Module Name

i 4= New Module

" Module
Create a new business integration module, & module is & project that is used for development, [ 7
wersion management, organizing resources, and deploving to the runtime environment. f ;
Module Mame: | FFP3InboundModule
¥ Use default location
Location; | : [Labfiles62 FlatFileInboundwiorkspace /FEPSInboundrModule Browse, .., |

¥ ©pen module assembly diagram

Business inteqration modules can be deploved and run on WebSphere Process Server, They can contain many

kvpes of components, such as business processes, assembled together for the purpose of business
integration.

___c. Ensure that the box next to Open module assembly diagram is checked and then click Finish.

You should see a new module, FFPSInboundModule, created from your Business Integration
window
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2. To start External Service from the Palette:

___a. From the Palette, on the left side of Assembly Diagram, click Inbound Adapters:

- ~
'?ccﬂ FFPSInboundiodule - Assembly Diagram &5

¢ nr Palette
[}3 ':i'l':fl':'l.:. i)
[~ Favorites

[Ep Companents
[~ Qutbound Adapters
[==Inbound Adapters  —

Ei iseries [an export component which
EI} oEc  |connects ko a local File system,

it 1D Edwards Enter. ..
r';“' Peoplesoft

[ oracle

[ sap

Qf-l' Siebel

3. Under Inbound Adapters, click the Flat File and then click the empty canvas of the assembly
diagram. The New Flat File Service wizard is opened

4. From the Flat File Service screen, select Create a service (advanced)

-} New Flat File Service
Flat File Service
..F
reate a new flat file service,
EIm

"~ Create a service From a pattern (kypical) [ﬁ' iCreake a service l{advanced}l

A ailable Patkerns:

= L_'é, Integration
E---ﬁ" Adapters
B[ Flat File

------ &“?' Create an inbound Flat File service to read From a local file

Descripbion:

The Flat File inbound pattern creates a service that retrieves a file from a directary on the local file system, |[a
If the file is nok in an =ML Format, wou can specify a data handler that will transform from the File content
Format to business objects. The file content can be split if the content contains multiple copies of the data
structure For processing.

___a. Click Next
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Note: You can also start the External Service from the File menu option:

From the main menu, select File > New > External Service. This opens an External Service wizard that
helps you obtain a service which establishes connectivity with other systems.

Select Adapters > Flat File and click Next

5. Onthe Select an Adapter screen, select IBM WebSphere Adapter for Flat Files (IBM : 6.2.0.0)
and click Next

#4= External Service

Select an Adapter

Select the adapter wou want ko use, D)

6. Adapter Import screen:

In this step, you will import a connector resource adapter archive from the file system into your WebSphere
Integration Developer workspace. The adapter RAR file already exists under <FFADAPTER_HOME>.

__a. The default Connector file is selected which is shipped along with WebSphere Integration
Developer

___b. Accept the default name for Connector project, CWYFF_FlatFile. You can change it to any other
name, but for this lab, you can leave the default name.

___c. For Target server, ensure that WebSphere Process Server v6.2 is selected

4= External Service M=] E3
Adapter Import !

Impart a resource adapker archive (RAR) From the file system ko create a conneckar "l '
project for the adapker, |

archive files CHIEMWIDE 2 Resourceddapters\FlatFile_g, 20,00 deployhCwyFF_FlatFile.rar
Conneckaor projeck:# | CWYFF_FlatFile

Targek runktime: v'ebSphere Process Server w6, 2

___d. Click Next

Note: The resource adapter archive file is imported and a new connector project, CWYFF_FlatFile, is
listed under Business Integration view.
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Note: If you are using the File menu option to start the External Service wizard, you are asked to select
the Processing Direction at this point. Select the radio button next to Inbound and click Next to proceed
to the next step.

7. Service Configuration Properties:

___a. Deploy connector project: ensure that the default option With module for use by single
application is selected

__b. Under Connection Configuration, click Browse... next to Event directory and select
<EVENT_DIR> from the pop-up window:

+4= External Service

Service Configuration Properties

For this service, specify security and connection configuration properties,

Deploy connector project: I'-.-'-.-'ith module For use by single application +j

Conneckion properties: ILIse properties below j

Conneckion propetties

File system connection information

Event directory:# I 1\Labfilessz\FlatFileInboundieventdir

Note: Alternatively, you can also replace the absolute directory path with WebSphere variables for the
Event directory, Archive directory. Refer to ‘Flat File adapter — Processing COBOL copy book files lab’
for more details on this new feature introduced in V6.2.

8. Rule Editor: Configure rules for event filtering.

Note: You will configure three rules to match three different file name patterns. Adapter polls only those
files, which match the rule that is configured here.

___a. Define a rule to filter only .txt files:
1) Click Add... next to the Rule Editor table
2) From the Add/Edit window, enter these:
a) Property Type: select FileName from the drop down list

b) Operator: select MATCHES FILE_PATTERN from the drop down list
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c¢) Value: *.txt

4= add,/Edit I [=]
Add/Edit properties
Specify the properties,

Properky Tvpe: IFiIeName j
Operatar: |MATCHES_FILE_PATTERN |
Yalue; # |*.txt

d) Click Finish

3) You should see a new rule entry in the table as shown below:

Fule Editor:

fdd. .,

Edit... |

___b. Repeat the above instructions listed in step 8.a and create two more rules as shown below:

Fil=Marne MATCHES FILE PATTERM

Rule Editor:
Property Tvpe | Operakar | 'u'e_ulue
Filerarme MATCHES_FILE_PATTERM * bxkZ —
FileMame MATCHES FILE PATTERM  *.bxtl . Edit,..
“FileMame MATCHES FILE PATTERM | *.tat
Rernove |

9. Click Advanced >> to see the hidden advanced properties that can be configured:

[ b Event polling configuration

[ b Event delivery configuration

[ b Ewvent persiskence configuration

[ F File archiving configuration

[ b Bidi properties

l
l
l
b Advanced Properties ]
l
l
l

[ b Logging and tracing

You can click each of the configuration and review the options available under it. For this lab, you will need
only some of these properties.
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___a. Event polling configuration: This has all the polling configuration details and for this lab, you can
accept the defaults.

__b. Event delivery configuration:

1) Ensure once-only event delivery: You should check this box only if you are using data
source and table name in the Event persistence configuration (below). If this property is set
to true, while using in-memory capability (explained below), the adapter will log a warning
message. By default this is selected and you can accept the default selection.

___c. Event persistence configuration:
1) Ensure that the Auto create event table is checked
2) Event recovery table name: FFPSTABLE

3) Event recovery data source (JNDI) name: jdbc/FF

Note: This represents the JNDI name of the Data Source used by Event Persistence to get the JDBC
database connection. The Data Source must be created in the WebSphere Process Server. You should
enter the data source JNDI name that you created in Step 3 of Part 1.

I ) ) 1
= Event persistence configuration

¥ Auto create event table

Event recovery table name: I FFPSTable

Event recovery data source (JNDI) name: Iju:ll:u:,.'FF

IUser name used to connect to event data source: I

Password used to connect to event data source: I

Database schema name; I

Note: The Event recovery data source (JNDI) name is not mandatory from V6.1. Now, the adapter can
use in-memory representation of event table to store all the necessary information. Adapter uses this
feature when event database information is not configured during inbound event polling. This feature will
not support the capability of handling “Ensure once-only event delivery”.

__d. Advanced Properties: Accept all the default values

1) Pass only file name and directory, not the content (FilePassByReference): This
property determines if the adapter needs to load the contents of the file or just provide
information on the directoryName and file name. If the value is true, the adapter just
provides the directory name and file name. This is not selected by default.

2) Include business object delimiter in the file content (IncludeEndBODelimiter): When
this property is set to true (selected) the delimiter (given in Split criteria) is appended to the
BO content before further processing is done. This property is valid only if you are splitting
the event files based on a delimiter, that is., only if the Split function class name (below) is
com.ibm.j2ca.utils.filesplit. SplitByDelimiter. This is not selected by default.

3) Split function class name: This value takes a fully qualified class name of the class to be
used in order to split the event file. It takes two values as of now:
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 com.ibm.j2ca.utils.filesplit.SplitBySize: a class which splits the event file based
on event file size. This is the default value for the split function class name.

e« com.ibm.j2ca.utils.filesplit.SplitByDelimiter: a class which splits the event file
based on delimiter(used to separate BO's in event file)

The delimiter or file size is specified in split criteria attribute.

4) Specify the criteria to split file content: This attribute takes different values based on
value set in Split function class name.

e If split function class name is set to com.ibm.j2ca.utils.filesplit.SplitBySize, then
split criteria must contain a valid number which represents the size in bytes. If
event file size is greater than this value, it is split into chunks of this value and so
many chunks are posted. If event file size is less than this value the entire event
file is posted in one shot. When split criteria=0 (default), chunking is disabled.

e If split function class name is set to
com.ibm.j2ca.utils.filesplit.SplitByDelimiter, then split criteria must contain the
delimiter which separates the BO'’s in the event file.

Note: You will use the SplitByDelimiter class later in the content specific (non-pass through) scenario

5) Poll subdirectories in event directory:

Note: ‘Poll subdirectories in event directory’ is the new Boolean property added in V6.2. This property
is used for recursive polling. Flat File adapter polls the given 'Event directory' and all the sub-directories
present in the 'Event directory'. Refer to ‘Log and confidential trace lab’ for more details on this new
feature

__e. File archiving configuration:

1) Archive directory: click Browse... and select <ARCHIVE_DIR>

I
 File archiving configuration

Specify archive directory to archive processed inbound event: files

Archive direckary: | C:1Labfilesa2iFlatFileInboundlarchivedir (—[M

File extension For archive: | ariginal

Surcess file extension Far archive: I sUCCESS

Failure file extension For archive: | Fail

Note: Alternatively, you can also replace the absolute directory path with WebSphere variables for the
Event directory, Archive directory. Refer to ‘Flat File adapter — Processing COBOL copy book files lab’
for more details on this new feature introduced in V6.2.

__f. Logging and tracing: Refer to ‘Log and confidential trace’ lab for more details on this new
feature

Function Selector Configuration: Function Selectors are required in order to map between events
generated by resource adapters and the appropriate SCA export function name.
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There are two function selectors provided by the adapter that are supported by the FlatFile adapter -
FilenameFunctionSelector and EmbeddedNameFunctionSelector.

FilenameFunctionSelector is used for generic FlatFile business object, where the object name cannot be
determined from the event file The FilenameFunctionSelector is a rule-based function selector that can
match a regular expression on a file name to an object name. This is represented in properties as a 2-
column table, with N rows. So, you can have a mapping as follows: For any event file with a .txt extension,
the corresponding object name is FFBG. The endpoint method name generated by the function selector in
this case is emitFFBG. You need to set this same name for the Native method property after you add the
operation.

You can also have same rules multiple times. If more than one rule matches, the function selector will
return the object name based on the first matching rule.

The function selector can be configured with multiple “rules”, each of which contains an object name, and
a regular expression to match against the file name. In the next part of this lab, you will create three such
rules.

10. Under Service properties, for Function selector options, select Use a function selector
configuration from the drop down menu

Note: If you select Use default function selector ‘FilenameFunctionSelector’ option for the Function
selector, the adapter automatically creates a function selector with FilenameFunctionSelector as the class
name. But, for this lab, you need to define three rules at the function selector and so you are going to
using the ‘Use a function selector configuration’ option.

___a. Click Select next to Function selector. The Binding Resource Configuration window is opened

Service properties

Ty tel e W= Tl el Ty =R <= = Furichion seleckor configuration

Function seleckar; Mot defined Select, ., |

___b. Under ‘Use existing function selector from the list’, select FilenameFunctionSelector
properties

#= Function Selector Configuration Hi=]

Select Function Selector

Select a function selector enkry from the list, IF wou want o use your own custom funckion |
seleckar then select the secand radio bukkon ko add your cuskom Funckion seleckar,

{* Use existing function selector from the list

= % EmbeddedhiameFunctionSelector propetties
R | amneFunctionSele

ckor properties
___c. Click Next

11. Define Function selector rules: In this step, you will define three different rules and object names
associated with those rules.
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When the adapter gets an event file, the function selector looks at the file type (ex: .txt, .tmp) and if
the type matches with any of the rules defined in this table, it will associate the corresponding

Object name of that rule to that event file.

FFBG Jtxt | emitFlatFileBG emitFFBG
FFTypel Jxtl emitFlatFilel emitFFypel
FFType2 Ftxt2 emitFlatFile2 emitFFype2

Note: Make a note of the Object name you specify here as you are going to use this in the later part

of the lab while specifying the Native method name.

___a. Click Add... next to the Function selector rules table

___b. From the Add/Edit pop-up window, enter these:

1) Object name: FFBG

2) Rule: *.txt

Rule:

Ohject name: | FFBG

|~

Note: You have now created a rule for the files of type .txt and an Object name corresponding to those file

type

3) Click Finish from Add/Edit window

___ . The above created rule is populated under Function selector rules:

Configuring function selector
Function selector rules:

FFBG

Qbject name

___d. Repeat Steps 9.a and 9.b to add these function selector rules:

2009 February, 18
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___e. You should see these three rules:

Configuring function selector
Function selector rules:
Object name Fule Add...
FFTypel it Edit... |
FFBG xt
Remove |

__f. Click Next
___g. Ensure that the selected module is FFPSInboundModule

___h. For Name, enter any string. For Ex: GenericFS

Maodule: IFFF'SInI:u::unu:IMD::IuIe j Brawse, ., | [Ew,. .
Mamespace: Ihttp:,l',l'FFP'SInI:u:uunu:IMu:u:Iule V¥ Default
Folder: I Browse, ., |
Marme:! | GeneicFs|
__i. Click Finish

12. You will now be back to External Service window and the function selector created in the above
steps is populated:

Setvice propetties

Function selector options: |lse a function seleckar configuration "_j

Function seleckar; * GenericFS

13. You can define data binding in two places - service level (current screen of External Service wizard)
or later at the method level (Operations screen of the External Service wizard). In this lab, you will
define data binding at the service level (from this screen)

___a. From the dropdown menu next to Data format options, select ‘Use a data binding
configuration for all operations’

Service properties

Function selector opkions: |se a function selectar configuration j

Function selector: * GeneticFS Select, ..

Data Farmat opkions: i1z & daka Format confiqurakion For all operations

[rata Farmat; Mot defined Select, .. |

___b. Click Select... next to Data format. A Binding Resource Configuration window is opened
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___c. Select the radio button for ‘Use existing data format transformation from the list’ and then
select FlatFileBaseDataBinding

= Data Binding Configuration

Select Data Format Transformation

Select a data Format transformation entry From the list, IF wou want to use wour own custom |
daka transformation then select the second radio butkon to add wour custom transformation, =

{* Use existing data format transformation from the list

FlatFileBaseDataBinding

___d. Click Next

Note: Data Handler Configuration: Since you are doing the pass through scenario, you do not need to
configure any data handler.

___e. Click Next from the Data Transformation Properties screen

4= Data Binding Configuration

Data Transformation Properties

Specify the properties for the data transformation, L

Select DataBinding if wou want ko use a data binding developed For earlier versions of the adapter.

Binding kype: DataHandler j

Configured daka handler: Mok defined

Configured data binding: Mok defined Seleck, ., |

___f. Note that the selected module is FFPSInboundModule

1) For the Name, enter FFPSDB

Module: IFFPSIanundMDduIe j Browse. .. | e, .
Mamespace: Ihttp:,l',l'FFF‘SInI:n:nundMn:nduIe v Default
Folder: I Browse. .. |
Narne: | FFPSDE
2) Click Finish

___g. Now the FFPSDB should be displayed for Data format:

[rata format options: =& a data Format configuration for all operations j
Data Farmak: # FFPSDE <%
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14. Check the box next to Change logging properties for wizard to view the output location of the log
file and the logging level. You can change the logging level using the drop down menu and click
Next

Following screen is the Operations screen where you can define all your operations.
From V6.1, you can select from three different Data types for any operation:

e User defined type

e Generic FlatFile business object

e Generic FlatFile business object with business graph
The pass through scenario of this lab demonstrates the creation of three operations (for the three rules you
have defined in the previous steps) using the Generic FlatFile business object and Generic FlatFile business
object with business graph data types.
Create emitFlatFileBG Operation:

15. From the Operations screen, click Add...

___a. Add Operation window is opened. Select Generic FlatFile business object with business
graph for the Data type and click Next

Operation properties

Data type for the operation:

You are back to Operation window and because you have chosen the data type with business graph,
the Input type is populated as FlatFileBG.

___b. For Operation name, enter any name, for Ex: emitFlatFileBG

___c. For Data format options, select Use a data binding configuration from the dropdown list
Define Data format:

__d. Click Select... next to Data format. A Binding Resource Configuration window is opened

___e. Ensure that the radio button for ‘Use existing data format transformation from the list’ and then
select FlatFileBaseDataBinding > FFPSDB

4= Data Binding Configuration

Select Data Format Transformation

Select a data Format transformation entey From the lisk, IF wou wank bo use wour own cuskom
data transformation then select the second radio button to add wour custom transformation.

i* Use existing data format transformation from the list

H
= @ FlatFileBaseDataBinding
b F‘-Eu FFPSDE
___f. Click Finish
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___g- Now the FFPSDB is displayed for Data format in the Add Operation window:

4% add Operation | _ O] =]
Operation
Specify the properties For the operation to add, ‘\-"1:| i
s |

Operation name: * IemitFIatFiIeEG I

Specify the operation input

Inpuk Evpe: IFIatFiIeBG {hkkp: e b, comyxmins/prodfwebsphen Browse, ., | {3 [=1 T |
Data Formak opkions: ILIse a daka format configuration H
Data Formak: * FFPSDE e [

___h. Click Finish. The above defined operation, emitFlatFileBG, is populated under Operations list

Operations:
------ emitFlatFileBG ({http: /fwww.ibm.comfxmins/prod/websphere fj2cafatfile ffatfilebg}FlatFileBG) : void

‘ Edit. .. |

Create emitFlatFilel Operation:
16. From the Operations screen, click Add...
___a. Select Generic FlatFile business object for the Data type and click Next

You are back to Operation window and because you have chosen the data type with no business
graph, the Input type is populated as FlatFile.

___b. For Operation name, enter emitFlatFilel

__c. Follow the instructions used to define data binding for emitFlatFileBG in the previous step, and
define the same FFPSDB for Data format

___d. Now the FFPSDB is displayed for Data format in the Add Operation window:

Dperation name: # I emitFIatFiIelI

Specify the operation input

Input Eype: I FlatFile {htkp: i fwea.ibm.comfxmins/prodfwebspherefj.  Browse.,.. | [, |
Drata Format options: ILIse a data Format configuration "_j
Data format: # FFPSDB
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___e. Click Finish. The above defined operations, emitFlatFilel, is populated under Operations list

Operations:

emitFlatFileBG ({http: /fwww.ibm, com/xmins/prod fwebspherefj2ca/fatfile fatfilebg}FlatFileBG) : void
i emitFlatFile 1 (http: f fwvww.ibm.com fxmins fprod fwebsphere fj2ca/fatfle/fatfleFlatFie) : void

Create emitFlatFile2 Operation

17. Repeat steps under ‘Create emitFlatFilel operation’ (Step15) to add one more operation,
emitFlatFile2, with these changes:

___a. Operation Name: emitFlatFile2

Cperation name; * I emitFlatFilez I

Specify the operation inpuk

Input Evpe; IFIatFile {hiktp: f e ibmn comyxmins/prodiwebsphere . Browse, .. | (= |
Data Farmak opkions: ILIse a data Farmat canfiguration -‘—j
[Data Format: * FFPSDE et Sicleicl,

18. You should now see these three operations:

Operations:

emitFlatFileBG ({http: ffwww.ibm. comfxminsprodwebsphere fj2cafatfile fAatfilebg}FlatFileBG) @ void
emitFlatFile 1 {{http:/ fwww.ibm. comfxmins fprod jwebsphere fj2cafatfile Aatfile}FlatFile) : void
emitFlatFile2 ({http:/fwww.ibm.comfxmins/prod fwebsphere fj2ca fflatfile ffatfile}FlatFie) : void

___a. Click Next from Operations screen
19. From Generate Artifacts screen:

___a. For Name, enter FFPSInboundIinterface

Properties For service

Module: IFFPSIanundMDduIe j MEW, .. |

Mamespace; |htl:p:,I',I'FFF‘SInI:u:uundMl:ndule,l'FFP'SInI:u:uundInterFal:e

¥ Use default namespace

Mdarme: # | FFPsInboundInterface
Descripkion: I
___b. Click Finish
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20. The Assembly diagram for FFPSInboundModule is opened with an Export component,
FFPSInboundinterface:

s *FFPaInboundiodule - Assembly Diagram X

1 —palette —
(NCECENE
[~ Favorites

[.—= Components

@ E,-l' FFPSInboundInterface

___a. Save (Ctrl + S) changes to your assembly diagram

Note: You need to manually change the Native method names.

The following table summarizes the rules, operations you have defined so far in this lab. Note the last
column, which shows the Native method name for each of the rule and operation defined:

FFBG Jxt emitFlatFileBG emitFFBG
FFTypel Fxtl emitFlatFilel emitFFypel
FFType2 Ftxt2 emitFlatFile2 emitFFype2

21. Change the Native method binding name

___a. Ensure that the FFPSInboundinterface is selected from the Assembly diagram
___b. From the bottom panel, select Properties > Binding > Method bindings

___¢. From the Bound Methods list, click emitFlatFileBG

__d. From the right side, ensure that the Generic tab is selected, and then change the Native method
to emitFFBG

-
Y Build petivities § T Properties 53

E_-, Prnblems} Setver Logs i Serverﬂ l_"ﬂ Asset Repnsitnries}
%] Export: FFPSInboundInterface (EIS Binding)

P—— = E unu:l .Methn!:ls Generic] Data Serialization |
.
Details _____ & emitFlatFils1 Bind rmethod
Qualifiers e 8 emitFlatFilez Mative method: * |ﬂ
Binding Method binding description:
End-paint configuration
|Methud bindings |

___e. From the Bound Methods list, click emitFlatFilel
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__f. Similarly, for emitFlatFilel, change the Native method to emitFFTypel

= Bound Methods Generic] Data Serialization |

------ 8 emitFlatFileBG

- Bind method

------ # emitFlatFile2 Mative method:
Method binding description:

___g. Similarly, for emitFlatFile2, change the Native method to emitFFType2

= Bound Methods Generic | Data Serialization |
48 emitFlatFileBG
..... ﬁ emitFlatFile 1 Bind method
L g E— Native method:

Method binding description:

___h. Save (Ctrl + S) your changes

22. Review the FFPSInboundModule: The generated Data Types, Interface, and Function selector

(GenericFS) and Data binding (FFPSDB) under Configured Resources can be found inside
FFPSInboundModule

Projects

B8 CUPYFF_FlatFile
E:g FFPSInboundmMadule

EFGS) s

=]

FFPSInboundInterface
[y .

----- . Dependencies

----- = Integrakion Logic

Elu'f‘—Lf" Data Types

-5~ FlatFile

[ FlatFilsB

InstruckuredContent

L=l @ Interfaces

;-----@IFFPSIanundInterFaceI

..... £ Mapping

-l Binding Resources

Y

5 GeneticFS

You can open each of these generated artifacts and business objects and review the properties inside.

Review the created methods inside the interface:

___a. From the Business Integration view, expand FFPSInboundModule > Interfaces and then double-
click FFPSInboundIinterface to open it
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___b. You should see these three operations:

0 FFPSInboundInterface

w0Operations - R I G

Cperations and their parameters

| Tarme | Twpe
v % emitFlatFi=BG
[ Inputis) | emitFlatFileBaInput | FlatFileBG
v s emitFlatFile 1]
[ Inputis) | emitFlatFile1Input | FlatFile
v ermitFlatFiez |
[ Input(s) | emitFlatFile2Input | FlatFile

___C. Close the interface, FFPSInboundinterface
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2.2. Add Java component

In this part of the lab, you will add a Java component and then wire the component to the existing Export
interface. The Java component is your endpoint.
1. Open the assembly diagram for FFPSInboundModule (if it is already not open)

___a. From the business integration view, expand FFPSInboundModule and double click Assembly
diagram

2. Drop a Java component to onto the assembly diagram

___a. From the Palette, click Components to expand it

¢ nr Palette
[y @)L= P )
|~ Favarites

[C“b Componenks

'-Té IUnkyped Component
5] Human Task

'-T'ﬂ lava L |
=) Medier@n Flo

2 Procddavd]

B Rule Group

Q.—:. State Machine

___b. Click Java and then click the empty space of FFPSInboundModule assembly diagram. This will
place a new component, Componentl on the assembly diagram.

3. Wire the FFPSInboundinterface to the Componentl
___a. Select the wire (EL:) icon from the Palette
___b. Click FFPSInboundinterface and then click Componentl to wire them together
___C. Select OK for the Add Wire pop-up window:
4= add Wire |

This ackion will allow the target service ko be used in ather madules, The
\:/ service interface from the export will be added ko the target, Do wou want ko
conkinue?

[ Always create without prompt

Cancel |

___d. From the top of the Palette, click the Selection Tool icon ( [‘}) to get back to the normal cursor
mode
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Your assembly diagram for FFPSInboundModule will look like this:

1 — palette —

|§ () (=) 5, @)

[~ Favorites
J
L= Components 'E' [2F FFPsInboundInterface @© & Componentt

—

___e. Right-click Componentl and select Generate Implementation from the pop-up menu
___f. On the Generate Implementation panel, select default package, and click OK

___g. Componentlimpl.java is opened in Assembly editor. Scroll down to the method emitFlatFileBG
that needs to be implemented and add this code under that method:

System.out .printIn("***********Inside emitFlatFileBG: type .txt

= Yy .

___h. Similarly add the print statement to emitFFTypel method:

System.out .printIn("********x***Inside emitFlatFilel:type .txtl

= iy .

___i. And finally, add the print statement to emitFFType2 method:

System.out .printIn("******x**x***Inside emitFlatFile2:type .txt2

= Yy .

___j. Save (Ctrl + S) and close Componentlimpl.java

___k. Save (Ctrl + S) and close Assembly diagram: FFPSInboundModule
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2.3. Test pass through scenario

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the pass through scenario.

1. Add the project to the WebSphere Test Environment server

___a. Right-click WebSphere Process Server v6.2 under the Servers view and select Add and
remove projects... from the pop-up menu

b. From the Add and Remove Projects window, select FFPSInboundModuleApp under Available
projects panel and click Add >

c. You will now see the FFPSInboundModuleApp added to the Configured projects

d. Click Finish and wait until the project is being published onto the server. The server will start in
Debug mode if it is not already started before

e. Click OK from Adding/Removing Projects pop-up. Optionally, you can select ‘Do not show again
so that you are not required to do this next time when you start the test client

4= Adding/Removing Projects Ed |

1

o

'2 The projects are being addedremoved From the server,

............................................

2. Test the application by providing three different input files:

Note: For your convenience, three test files, sample.txt, sample.txtl, sample.txt2 are placed in
<FFFILES>.

Test scenario 1: .txt files

___a. Copy the sample.txt file from <FFFILES> to <EVENT_DIR>. The adapter will poll the copied file
from the event directory and will transfer it to the archive directory
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___b. Because you have placed a .txt file, it will pass through the emitFlatFileBG method and you
should see this message in your Server Logs view (or SystemOut.log):

e —_
L7y Build Activities (I_I Properties ([3_ Problems Server Logs &4 i Servers} Fﬁl Asset Repnsitnries] =
eI
"Welcare WebSphere Process Server w6, 2 at localhost 23 ]
Console {filtered): WebSphere Process Server vb.2 at localhost
Show All Record Types (Hierarchical) = with only Server State and Error Conkents {Page 1 of 1)
pe | - T g | Thread ID | Zonkents |
O = Log message Dec 11, 2008 14;21:31.531 00000059 Aktemnpling bo resolve imported File: File: /i S TEMMWIDEZ pE v, .
O = Log message Dec 11, 2008 14:21:36.421 00000059 WSWROZZ11: Application started: TaskiZontainer_widhode_s. .
D = Log message Dec 11, 2008 14:23:18.421 0o0o000a WAWROOD1I: Server serverl apen For e-business
D = Log message Dec 11, 2005 14:23:52.656 00000075 WSYROZ00T: Starting application: IBMUTC
D = Log message Dec 11, 2005 14:23:54.843 00000075 WSYROZZ11: Application skarted; IBMUTC
O = Log message Dec 15, 2003 12:47:05.062 Q0000079 WSYROZ00T: Skarting application: FFPSInboundModulespp
a = Log message Dec 15, 2008 12:47:18,953 00000079 WAWROZZ11: Application started: FFPSInboundModulespp
[ B Log message Dec 15, 2007 . ) ekestspdekkdsk R T cide arnikFlatFileBs: bype kxt Filmgttakebohokske

___C. To verify your test results, check the <ARCHIVE_DIR> subdirectory which should contain an
archive of the event file, with the same file name appended with year, month, date, system time,
and success

fddress (0 Cr\Labfilest2\FlatFileInbound' archivedie

Falders x

= I3 FlatFileInbound -
I archivedi

§ | Size I Twpe |
1KE SUCCESS File

Test scenario 2: .txtl files:

___d. Copy the sample.txtl file from <FFFILES> to <EVENT_DIR>. The adapter will poll the copied
file from the event directory and will transfer it to the archive directory

___e. Because you have placed a .txt1 file, it will pass through the emitFlatFilel method and you
should see this message in your Server Logs view (or SystemOut.log):

O [5) Log message Dec 15, 2005 12:47:15.953 Q000007e WSYROZ211: Application skarted: FFPSInboundModuledpp
O [5) Log message Dec 15, 2005 12:47:42.453 Qooo0oks AR Inside emitFlatFileBE: bype bk Filagtetsterteir
B B Logmessage Dec 15, 2 12:49:52.046 i *Inside emitFlatFileBG: bype kxkl Files* i

___f. To verify your test results, check the <ARCHIVE_DIR> subdirectory which should contain an
archive of the event file, with the same file name appended with year, month, date, system time,
and success

fddress [ i Labfilesaz\FlatFileInboundyarchivedir

Folders X || Mame = | Size | Type |
= lil FlatFileInbound :I msample.txt.2["]8_09_2'9_13_3?_25_812.su|:n:ess 1KE SIUCCESS File

£ archivedic sample bxtl, 2008 09 29 15 3 1 KB SUCCESS File
== eventdir

27 906, success
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Test scenario: .txt2 files:

___g. Copy the sample.txt2 file from <FFFILES> to <EVENT_DIR>. The adapter will poll the copied
file from the event directory and will transfer it to the archive directory

___h. Because you have placed a .txt2 file, it will pass through the emitFFType2 method and you
should see this message in your Server Logs view (or SystemOut.log):

O [Z) Log message Dec 15, 2005 12:47:42.453 000000bsS Fkkkkdkkr Rt Inside emitFlatFileBG: bype bk filasttskrtdders

O [Z) Log message Dec 15, 2005 12:49:52.046 000000be Akt Inside emitFlatFileBG: bype bukl Filastotrssers
Dec ]_I:II 2008 12:50:52 .01 :+::+::+::+::+::+::+::+::+::+::+:]:n5il:|Ee EFI'IitF'EItF"EEEiG: t':."l:lEf k= Fi|E5:+::+::+::+::+::+::+::+:I”

B B Logmessage

___i. To verify your test results, check the <ARCHIVE_DIR> subdirectory which should contain an
archive of the event file, with the same file name appended with year, month, date, system time,
and success

fddress | Ci\Labfiles62)FlatFileInbound' ar chivedi

Falders x Marne = | Size | Tvpe |
= 15 FlatFileInbound LI msample.I:xl:.2DDB_D9_29_13_3?_25_812.5|.||:|:ess 1KB SIICCESS File
5 archivedic |_ﬂsample.txt1 Z005_09_29 13 3527 906,50Ccess 1KE SUCCESS File
) eventdir sample.txkz 2005 _| 9 13 39 _0Z_593,sUccess 1KE SUCCESS File

3. Restore the Sever Configuration

___a. Right-click WebSphere Process Server v6.2 under the Servers view and select Add and
remove projects... from the pop-up menu

___b. Select FFPSInboundModuleApp under Configured projects and click < Remove

___c. Click Finish after you see the application moved to Available projects. Wait until the application
is being unpublished
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2.4. Test pass through scenario with SplitBySize

In this last part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the pass through scenario with split by size.

1. Configure/change the adapter properties from the Properties view:
__a. Change to Business Integration perspective if you are in a different perspective
1) Select Window > Open Perspective > Other...
2) From the Select Perspective window, select Business Integration (default) and click OK

___b. Expand FFPSInboundModule and double-click FFPSInboundModule to open it in Assembly
Editor

___C. Click FFPSInboundinterface from the Assembly Editor and select Properties tab from the
bottom

__d. Select Binding under Properties and select End-point configuration under Binding itself and
then select the Connection tab

___e. Now under ActivationSpec Properties, you can review the properties that were given during
the external service wizard

__f. Scroll down to Advanced Properties
1) Select the box for ‘Split file content based on size (bytes) or delimiter’
2) Split function class name: com.ibm.j2ca.utils.filesplit.SplitBySize (default)

3) Specify criteria to split file content: 1000

Note: The value, 1000, you entered for the field, Specify criteria to split the content, is the size of the input
file in Bytes.

Advanced Properties
Ratrava filar with patfarm. e

O Fass oniy ffe name and directory, nof Bhe confant
O motugie busness ohiact defndar i e fle confent

Refrigve filar i1 sorfed ordar: Mo sork IE'

Aa confant encoding: UTF-&

Spact) Hhe sodttng funchion casr name and the soit criteria fo soiF fhe e confent
Sndt Ale confend hazed on sie fhytes! or dﬂﬁ:in-'ferl

EndE funchion ofase name. corm.ibm.j2ca. ukils, filesplit, SplitEy Size  alf— Browse, ..
Sheciy crteria fo 5ol e confent: 1000 if—

O Foif subdiactorias in event directory

___g. Click Assembly diagram (or any where else so that the save button is enabled) and then save
(Ctrl +S) your changes
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___a. From the assembly diagram of FFPSInboundModule, double-click Componentl

___b. Componentlimpl.java is opened in Assembly editor. Scroll down to the method emitFlatFileBG
and add this code under that method:
System.out .printIn('"********x***Insijde emitFlatFileBG: type .txt
fi Ies************' ') ;
DataObject FlatFile = emitFlatFileBGInput.getDataObject("'FlatFile');
DataObject Unstructured = FlatFile.getDataObject("'Content™);
String astext = Unstructured.getString("'AsText');

System.out .printIn("'File content

> ""t+astext);

Note: You can also copy the Java code from <FFFILES>\SplitBySizeJavaCode.txt.

__C. Save (Ctrl + S) and close Componentlimpl.java

___d. Save (Ctrl + S) and close Assembly diagram: FFPSInboundModule

3. Repeat Step 1 of part 2.3 to add the saved project FFPSInboundModuleApp to the server

4. Test the application with and input file larger than 1000 Bytes

Note: For your convenience, a test file SplitBySize.txt is placed in <FFFILES>. The size of the file is

around 3KB.

___a. Copy the SplitBySize.txt file from <FFFILES> to <EVENT_DIR>. The adapter will poll the
copied file from the event directory and will transfer it to the archive directory

5.  Verify your results

___a. Because you have placed a .txt file, it will pass through the emitFlatFileBG method and you
should see this message in your Server Logs view

O = Log message
O = Log message
O = Log message
O = Log message
O = Log message
O = Log message

2009 February, 18

Dec 15, 2008 12:57:25,890 000000be FhdRREEE R I nside emitFlatFileBa: bvpe bxb  filag¥dttekt
Dec 15, 2003 12:57:25.5%90 000000be File content----- = SplitBySize test content Segment 1:
Dec 15, 2008 12:57:26,109 000000be FhdRREEE R I nside emitFlatFileBa: bvpe bxb  filag¥dttekt
Dec 15, 2003 12:57:26,109 000000be File content----- = SplitBySize tesk content Segment 2:
Dec 15, 2008 12:57:26,234 000000be FhdRREEE R I nside emitFlatFileBa: bvpe bxb  filag¥dttekt
Dec 15, 2003 12:57:26.234 000000be File content----- = SplitBySize test content Segment 3:
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___b. For full stack of message, open your SystemOut.log located at
<WID_HOME>\pfiwps\logs\serverl and verify this message:

[ = consde > w6l A B -[G-"%
‘\WebSphere Process Server w6, 1 [WebSphere Pracess Server] WebSphere Pracess Server w6.1 (WebSphere w6.1)

[1/9/08 13:10:05:250 C3T] 0000008d SystemCut O wFFaEF*Es s+ Inzside emitFlatFileBG: type .txt fileg*sFssrssrsrs
[1/9/08 13:10:05:250 C3T] 0000008d Swystemiut O File content—--—-——- > SplitByl3ize test content Segwent 1:

A N A T A A A T R A T A T R T A T N A A A A A AN F A A AN A A AN AN A A TR ARG T R T RS TR ERS TN

s

L L R T T
A N A T A A A T R A T A T R T A T N A A A A A AN F A A AN A A AN AN A A TR ARG T R T RS TR ERS TN
A N A T A A A T R A T A T R T A T N A A A A A AN F A A AN A A AN AN A A TR ARG T R T RS TR ERS TN
LR L R T L R T

N A A A T A A A A A A A AN R TN R AN R AN R AN A R AN R AN TR AN AR AR AR AR AR A A AR A AT A AR AR A AT RSN A A RS A AAAS N AT AA NN

[1/9/08 13:10:05:281 C3T] 00000051 SystemOut O #wrxwrrwrrrrsInzide ewmitFlatFileBG: type .txt files#rdrrsrsrry
[1/9/08 13:10:05:281 C3IT] 00000091 SystemCut ¢ File content—---——-— > SplitBySize test content Segment 2:
[1/9/08 13:10:05:312 C3T] 00000092 SystemCut QO wrwmEwTErAsInside emitFlatFileBG: type .txt filegvrrswssssnaw
[1/2/08 13:10:05:312 CST] 00000032 Systemout 0 File content—--——- > BplitBy3ize test content Segment 3:

333333333335 333 353035353553 53535355 3533533335333 3333333333353 53535353535535335355353 353333533333 3333353335333 335333333335333333333333333333
B3BBG 3330300353353 5353555355535 5353553533533 35333533353 35303535330350353353355353 5535535353535 353 3353533353533 3303353353333333333553335333333333
3335333553003 355 35305550030 555 3355355353355 3 5355535533055 533353 53553535553 35553 553533555353 5535 53553035553 53535353 33333553 535353533333335333333333333
3335333553000 355 535305550030 555 3355355353355 3 5355535533055 5353353 53553535553 3555355353355535359535 53553035553 5353535333333553535335333333335333333333333
B3B3 350330305303 303 3035353533333 3333533533353 333353 0353503303553 553503303553 3533335333353 333 33333533333333333333333333333333333333

Note: The same SplitBySize.txt file, if delivered without specifying Split criteria to 1000 (about 1KB), will
reach the end point only once. Here, in this part, you saw the successful event delivery message for three
times for the same file (with the file size being 3KB) because of the split criteria that has been given as
1KB, which means it splits the file into three parts and delivers to the endpoint.

1) Check your <ARCHIVE_DIR> which should contain an archive of the event file, with the
same file name appended with year, month, date, system time, and success

Address | C:\LabfilesszFlatFileInbound) archivedic
Falders X || Mame =~ | Size | Tvpe
E I FlatFileInbaund ;I sample.txtl 2008_12_15 172 49 52 015,50ccess 1 KB SUCCESS File
= \archivedir sample.txt2.2E|E|8_12_15_12_5E|_32_E|15.success 1KE SUCCESS File
) eventdir sample.txt.2DDS_12_15_12_4?‘_41_906.success 1KE SUCCESS File
) workspace 5 3KB SUCCESS File

6. Restore the Sever Configuration: follow the instructions under Step 3 of Part 2.3
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Part 3: Content specific (non-pass through) scenario
Of the two flows, you have just tested the pass through scenario that does not involve data transformation.
In this part of the lab, you will configure the non-pass through scenario using the new External Service
option from the WebSphere Integration Developer and then test the configuration with different cases.

Content specific flow for the inbound scenario:

FS invokes the DataBinding. Uses SDO
returned to denve function name.

CustomerWrapperBG

 Event data is picked from the event file based on SplitCriteria, converted into a byte[], and set on
FlatFileInputStreamRecord.

e Protocol specific information like event file name, directory name are also set in the
FlatFileInputStreamRecord.

e The FlatFileInputStreamRecord is sent to the Foundation Class and from there to the Function
Selector. The Function Selector instantiates the wrapper and then based on the data handler property
value in the chosen databinding, the Function Selector will invoke that data binding and get back a
content specific data object (Customer SDO).

e This content specific data object is set on the wrapper data object. Protocol specific information is also
set the wrapper. The wrapper is set in a BG and sent to the end point.
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3.1. Configure content specific (non-pass through) scenario using
External Service wizard

In this part of the lab you will use this new External Service feature to create and configure the Function
Selector, Data Handler, and Data Binding and other required artifacts to test the inbound pass through
scenario

1. Create FFCustominboundModule
___a. From the Business Integration window, right-click and select New > Module
__b. From the New Module window, enter FFCustominboundModule for the Module Name
___c. Ensure that the box next to Open module assembly diagram is checked and then click Finish

You will now see a new module, FFCustomInboundModule, created from your Business Integration
window

2. Import required business objects

___a. Expand FFCustomInboundModule (if not already expanded), right-click Data Types and select
Import... from the pop-up menu

___b. From the Import window, expand General and select File System and then click Next
___c. Enter From directory

1) Click Browse... next to From directory

2) From the Import from directory window, select <FFFILES > and click OK

Now, you will see FFFiles folder added on the left side, and all the xsds and files under that folder on
the right side.

___d. Select the box next to Customer.xsd and Order.xsd
__e. Ensure that the FFCustomInboundModule is selected for Into folder
___f. Click Finish from the Import window
The Business Integration window is updated with the imported business objects.
3. Review imported business objects:

___a. Expand FFCustominboundModule > Data Types and you will now see two new data types
Customer and Order under it.
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___b. Double-click Customer review the fields inside the object:

- q
[ Customer

[8] customerMame string

[8] Address string
[8] City string
[8] 5tate string

| I -'";-:E]I

4. Now, double-click Order and review the fields inside the object:

r o
[Z] rder

i |
[€] CrderMumber string
[e] OrderType  string
[8] Quantity string
[] Price string

L )

5. After reviewing, close the Customer business object from the Assembly editor
6. To start External Service from the Palette:
___a. From the Palette on the left side of Assembly Diagram, click Inbound Adapters:

7. Under Inbound Adapters, click the Flat File and then click the empty canvas of the assembly
diagram. The New Flat File Service wizard is opened

8. From the Flat File Service screen, select Create a service (advanced)

4= New Flat File Service | x|
Flat File Service J -
Create a new flat file service, :...
" Create a service from a pattern (bypical)
Filter: | twpe filter text
&wailable Patterns
E @ Adapters
B[S Flat File
b %ﬁ Create an inbound Flat File service to read from a local file
___a. Click Next
Note: You can also start the External Service from the File menu option:
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From the main menu, select File > New > External Service. This opens an External Service wizard that
helps you obtain a service which establishes connectivity with other systems. Select Adapters > Flat File
and click Next

9. Onthe Select an Adapter screen, expand IBM WebSphere Adapter for Flat Files (IBM : 6.2.0.0)
and select CWYFF_FlatFile

o,
=] |_| IEM WebSphere Adapter For Flak Files (IBM : 6,2.0.0)
RO 1 FF kil

___a. Click Next

Note: If you are using the File menu option to start the External Service wizard, you are asked to select
the Processing Direction at this point. Select the radio button next to Inbound and click Next to proceed

to the next step.

10. Service Configuration Properties:

___a. Deploy connector project: ensure that the default option With module for use by single
application is selected

___b. Under Connection Configuration, click Browse... next to Event directory and select
<EVENT_DIR> from the pop-up window:

4= External Service

Service Confiquration Properties

For this service, specify security and connection configuration properties,

Deploy connectar project: IWith module For use by single application -‘—j

Conneckion properties: ILIse properties below j

Conneckion properties

File system connection information

Event directary | Z:1Labfilesc2iFlatFileInboundieventdic

___c. Click Advanced >> to see the hidden advanced properties that can be configured:

You can click each of the configuration and review the options available under it. This lab guides you
through some of the important and required configurations.
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___d. Event persistence configuration:
1) Ensure that the Auto create event table is checked
2) Event recovery table name: FFCustomTable

3) Event recovery data source (JNDI) name: jdbc/FF

Note: This represents the JNDI name of the Data Source used by Event Persistence to get the JDBC
database connection. The Data Source must be created in the WebSphere Process Server. You can use
the same data source JNDI name that you created in Step 3 of Part 1

r

 Event persistence configuration

¥ Auto create event table

Event recovery table name: | FFCustomTable

Event recovery daka source (JMDI) name: | jdbc)iFF

User name used to conneck to event data source: |

Password used ko connect to event data source: |

Database schema name: |

Note: The Event recovery data source (JNDI) name is not mandatory from V6.1. Now, the adapter can
use in-memory representation of event table to store all the necessary information. Adapter uses this
feature when event database information is not configured during inbound event polling. This feature will
not support the capability of handling “Ensure once-only event delivery”.

___e. File archiving configuration:

1) Archive directory: click Browse... and select <ARCHIVE_DIR>

I
 File archiving configuration

Specify archive directory to archive processed inbound event: files

Archive direckary: | C:1Labfilesa2iFlatFileInboundlarchivedir (—[M

File extension For archive: | ariginal

Surcess file extension Far archive: I sUCCESS

Failure file extension For archive: | Fail

Function Selector Configuration: Of the two function selectors that are supported by the FlatFile
adapter, FilenameFunctionSelector was used for pass through scenario. The
EmbeddedNameFunctionSelector is used in case of content-specific business objects, where the
object name is embedded in the event file. For example, if the content-specific business object is
CustomerWrapperBG, the function returned by the function selector is emitCustomer. This function
selector should be configured with a data handler. The data binding should be the adapter-specific
WrapperDataBinding. The data binding should be configured to use the same data handler configured
with the function selector.

11. Under Service properties, for Function selector options, select Use a function selector
configuration from the drop down menu
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Note: If you select Use default function selector ‘FilenameFunctionSelector’ option for the Function
selector, the adapter automatically creates a function selector with FilenameFunctionSelector as the class
name. For non-pass through scenario, you need to define a function selector that uses
EmbeddedNameFunctionSelector.

___a. Click Select next to Function selector. The Binding Resource Configuration window is opened

___b. Under ‘Use existing function selector from the list’, select FilenameFunctionSelector
properties

= Function Selector Configuration M=] E3

Select Function Selector

Select a function seleckar entry Frarm the lisk, IF wou wank ko use yaur awn custom Funckion |
selectar then select the second radio bukkon ko add wour custom function seleckar, =l

{* Use existing function selector from the list

e g:ﬁ

¥ FilenameFunctionSelector properties

EmbeddediameFunctionSeleckar properties

i” Gelect your custom function selector from the workspace

Function selectar class name: Select... |

[T add custom class bo binding registhy

Description:

| EmbeddedMameFunctionselector properties

___C. Click Next

The following screen is Function Selector Properties screen where you will define the data handler and
encoding used in inbound processing.

Data handler configuration:

___d. Click Select... next to Data handler configuration name. A Binding Resource Configuration
window is opened for you to define the data handler
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___e. Under ‘Use existing data format transformation from the list’, select XML >
UTF8XMLDataHandler

Note: UTF8XMLDataHandler listed under XML is the predefined data handler with UTF-8 as the encoding.
You can also select XML and then select the encoding of your choice in the next screen to define a data
handler of your choice.

+= Data Handler Configuration [_ O]

Select Data Format Transformation

Select a data Format transformation entey From the list, IF you want ko use your own cuskom |
data transformation then select the second radio button to add wour custom kransformation. =l

¥ Use existing data format transformation from the list

L2 Delmited

----- %.. Handled by W Invoker
%.. JAxE based Java bean
- 150m

SR FT

MLDakaHandler

" Select your custom data format transformation from the workspace

Data kransformation class name: I Seleck, |

™| Add custom class bo binding registry:

Descripkion:

2n inbound, parses UTF-8 encoded ¥ML data inka a business object, On outhound, serializes business
object to UTF-& encoded %ML daka,

___f. Click Finish

___g. From the next screen, the Data handler configuration name, UTF8XMLDataHandler is displayed
which was selected in the previous steps

#% Function Selector Configuration

Function Selector Properties

Specify the properties For the function seleckar, |

Data handler configuration name: UTFSRMLDataHandler sl Select, .,

___h. Click Next
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___i. From the New Function Selector Configuration screen, enter CustomFS for Name

4= Binding Resource Configuration H[=]

New Function Selector Configuration

Create a new Function selector configuration. Specify the module, folder, |
namespace, and name for the funckion selector configuration, =l

Madule: IFFCustnmInhDundMDdule j Brawse, ., | e, ., |
Namespace: Ihttp:,I',l'FFCust-:umInI:u:uundI“-’Iudule v Default
Folder: I Browse, ., |
Marne: | CuskomFS
___j- Click Finish

You are now done with configuring the Function Selector, CustomFS and, in that process, configured a
data handler, CustomDH. You are back to the External Service wizard and the above configured
function selector, CustomFS is displayed for Function selector configuration field:

Sekvice properties

Function seleckor options: |Use a function selector configuration *‘_j

Function selectar: # uskomFs el S|k .

Data binding configuration:

12. You can define data binding in two places - service level (current screen of External Service wizard)
or later at the method level (Operations screen of the External Service wizard). In this lab, you will
define data binding at the service level (from this screen)

___a. From the dropdown menu next to Data format options, select ‘Use a data binding
configuration for all operations’

Drata Format opkions: ilse a daka Format configuration For all operations

Drata Farmat; Mot defined Select. .. |

___b. Click Select... next to Data format. A Binding Resource Configuration window is opened
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___c. Select the radio button for ‘Use existing data format transformation from the list’ and then
select FlatFileBaseDataBinding

= Data Binding Configuration

Select Data Format Transformation

Select a data Format transformation entry From the list, IF wou want to use wour own custom |
daka transformation then select the second radio butkon to add wour custom transformation, =

{* Use existing data format transformation from the list

FlatFileBaseDataBinding

___d. Click Next
___e. Select the UTF8XMLDataHandler for data handler:
1) Click Select next to ‘Configured data handler’

2) From the Binding Resource Configuration window, select XML > UTF8XMLDataHandler
listed under ‘Use existing data format transformation from the list’

3) Click Finish

__f. Back to Data Transformation Properties and the selected data handler ‘UTF8XMLDataHandler’
is displayed here:

+= Data Binding Configuration

Data Transformation Properties

Specify the properties For the daka kransformation, |

Select DataBinding if wou wank ko use a data binding developed For earlier wersions of the

adapker,
Binding type: DataHandler "_j
Configured data handler; UTFE=MLDataHandler <% Select. ..
Configured data binding: Mot defined Select, ., |
___g. Click Next
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___h. Note that the selected module is FFCustomIinboundModule

1) For the Name, enter CustomDB

Module: IFFCustDmInbnundMDdule j Brawse, ., | MEw, ..,
Mamespace: Ihttp:,l',l'FFCustu:umInI:u:-undMu:-dule v Default
Folder; I Browse, ., |
Mame: | CusktomDE
2) Click Finish

___i. Now the CustomDB should be displayed for Data format

Service properties

Function selector options: ILIse a function seleckor configuration j

Funiction selector: # CustomFs Select. .. |
Drata Farmat opkions; ILIse a data farmat configuration Faor all operations "—j

Daka Format: # CustomDB e Sleit,

13. Check the box next to Change logging properties for wizard to view the output location of the log
file and the logging level and click Next

Define emitCustomerFile operation:
_____14. From the Operations screen, click Add...
Add Operation window is opened
___a. Select User defined type for the Data type and click Next

4= Add Operation x|

Operation = -
Select the operation kind. 53

Operation properties
Data type for the operation: M= ==y

(7) = Back I Mext = I Einiish Cancel

You are now back to Operation window and because you chose the User defined data type, the Input
type is blank and because you have selected Output required box, the Output type is
CreateResponse
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___b. For Operation name, enter emitCustomerFile
___c. Define Input type:
1) Click New... next to Input type to open a New Business Object window

2) From this window, ensure that the Module selected is FFCustominboundModule and click
Next

3) Click Browse... next to Data type
4) From the Data Type Selection window, select Customer under Matching data types:

Matching data byvpes:

_ustomer
[CJ Order
Cualifier:
[ hitkp: f v, ibm . com x=mins) prodfiwebspherefi2ca) Flakfilecustorm
1] | -

5) Click OK

6) From the wizard, check the box next to Generate business graph for each business
object

7) Do not check the box for ‘Generate retrieve container to retrieve multiple business
objects’

Note: The ‘Generate retrieve container to retrieve multiple business objects’ is used only during outbound
retrieve operation.

4= New Business Object Hi=]
Business Object Properties P

Specify the properties for the new business object, H'/J_'

Data kype: # | Cuskomer {htkp:f e ibm, comyxmins/prodfwebsphereMie= Browse,. | Mew. . |

[|7 isenerate business graph For each business -:ul:ujectél

Mamespace for generated business graph and container objeck,

Business object namespace; | hikkps § e, b, com)=mins fprod fwebspherei2ca)flatFile

[™ Generate retrisve container ko retrieve mulkiple business objects  slE——
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8) Click Finish

___d. The Input type in Add Operation window is populated with CustomerWrapperBG, because you
have selected to have business graph (BG) generated

___e. For Data format options, accept the default selection Use data format configuration
‘CustomDB’ from the dropdown list

#4= Add Dperation [_|O]

Operation
@

Specify the properties for the operation bo add,

Operation name: * I emitZuskomerFile I

Specify the operation input

Input kype: * ICustDmerWrapperBG {hkkp: e ibm. comyxmins)proc «m—'- Mew, .,

[rata Format options: ILIse data Farmat configuration "CustomDE' "_j

[ata Format: Mot defined Seleck, ., |

___f. Click Finish

___g. The above defined operation, emitCustomerFile, is populated in the Operations list

Operations:

emitCustomerFile ({http:/fwww.ibm. comxmins fprod fwebspherefj2ca fliatfile foustomerwrapperbg }CustomerWrapperBG) @ vaid

Define emitOrderFile operation:
_____15. From the Operations screen, click Add...
Add Operation window is opened
___a. Select User defined type for the Data type and click Next

You are back to Operation window and because you chose the User defined data type, the Data type
is blank.

___b. For Operation name, enter emitOrderFile
___c. Define Data type:
1) Click New... next to Input type to open a new window

2) From the next screen, ensure that FFCustomIinboundModule is selected and click Next

3) Click Browse... next to Data type
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4) From the Data Type Selection window, select Order under Matching data types:

Matching daka bypes:

I:I Customer
Iil Cusktomer'Wrapper
CustumerWrapperBG

WOorder

5) Click OK
6) Do not check the box next to Generate business graph for each business object

7) Do not check the box for ‘Generate retrieve container to retrieve multiple business
objects’

Note: From V6.1, the generation of business graph is optional and you can leave this option unchecked.
As a result, Adapter will not generate the BG for Order business object and you can confirm this bye
reviewing the generated data types from the business integration view of your WebSphere Integration
Developer.

Note: The ‘Generate retrieve container to retrieve multiple business objects’ is used only during outbound
retrieve operation.

Daka tvpe: # IOrder {hkEp: f e, ibm, comy'=mins)prod/websphere j==— Erowse... | MNew..,

@Generate business graph for each business object

Mamespace for generated business graph and container object.

Business object namespace: | Rikkpe v, ibm. carmmins prod fvwebspher e fi2c a Flatfile

@enerate retrieve container ba retrigve mulkiple business objects.
8) Click Finish

___d. The Input Type in Add Operation window is populated with OrderWrapper, because you have
not selected to have business graph (BG) generated

___e. For Data format options, accept the default selection Use data format configuration
‘CustomDB’ from the dropdown list

Cperakion name: # IemitOrderFiIe I

Specify the operation inpuk

Input bype: # |Or|:|er'-.-'-.-'rapper {http:,l',l'www.ibm.cnm!xmlnsiprud!webw {

Data Farmat options: IUse data Farmat configuration "CuskamDE! "—j

[ata Format; Mot defined Select,,, |

___f. Click Finish
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___g. The above defined operation, emitOrderFile, is populated in the Operations list

Operations:

emitCustomerFile {({http: ffwww.ibm.com fxminsfprod websphere fj2ca fatfile fcustomerwrapperba}CustomerWrapperBG) @ void
‘- 8% emitOrderFile {{hitp:/fewewe.ibm. com xmins /prod websphere fi2ca/fatfile forderwrapper}OrderWrapper) : void

___h. Click Next
16. From the Generate Artifacts screen, enter these:

___a. For Name, enter FFCustomlnboundIinterface

Propetties Far service

IModule: IFFCustnmInbuundMndule j MEw, . |

Mamespace; |http:,l',l'FFCustl:umInI:u:uundMl:ul:IuIe,l'FFCustl:umInl:n:uunl:IInterFace

¥ Use default namespace

Marne: #* | FRCuskormInboundInterface |

Descripkion: I

___b. Click Finish

17. You will now see a new export component, FFCustominboundIinterface in the assembly diagram
of FFCustomInboundModule

o o
'] *FFCustominboundModuls - Assembly Diagram &3
L . LS ST RE——

d e Palette
s EEL B,

| L Favorites.

':E;J ?;, FFCustomInboundInterface

___a. Save (Ctrl+S) your changes to the assembly diagram
18. Review the generated Native method bindings for the defined operations:
___a. Ensure that the FFCustomInboundinterface is selected from the Assembly diagram

___b. From the bottom panel, select Properties > Binding > Method bindings

Note: The Native method name should be ‘emit’ added as a prefix to the business object name, that is.,
Native method = emit + Business Object name. In this case, for the processed business object is
Customer, the Native method is emitCustomer and for Order it is emitOrder.

__c¢. From the Bound Methods list, click emitCustomerFile and you should see emitCustomer as the
Native method

___d. Now, click emitOrderFile from Bound Methods and you should see emitOrder as the Native
method
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19. Review FFCustominboundModule: The generated Data Types, Interface, and the Function selector

(CustomFS) Data binding (CustomDB), and Data handler (UTF8XMLDataHandler) under

Configured Resources can be found inside FFCustomIinboundModule

Elﬂ FFCustomInboundiodule
El?f;l Aszsembly Diagram
- 'ﬂ FFCustomInboundInterface
----- @E Dependencies
----- =3 Inkegration Logic
4= Data Types
[:J Cuskomer
,.:._] Cuskomerwrapper
CuskomerWrapperBa
(2] Order
“407] Cirderwrapper
El- @ Tnterfaces
- @ FFCustomInboundInkerface
..... 2 Mapping
=-fa Binding Resources
ElE? common_onfigur skions
el UTFSXMLDat aHandler
----- F‘lE-u CuskomDE
----- ZuskamFS

You can open each of these generated artifacts and business objects and review the properties inside.

Review the created methods inside the interface:

___a. From the Business Integration view, expand FFCustomInboundModule > Interfaces and then

double-click FFCustomInboundinterface to open it

___b. You should see these two operations:

FCustomInboundInterface X

=0Operations Y | pl P e
Cperations and their parameters
| Marne | Tvpe
ﬂsemittustamerﬁle I
L1 Inpukis) | emit_uskomerFileInput | CustomerwrapperBa
w % emitOrderFile |
E# Input(s) | emitorderFilelnput | Qrderwrapper

___c. Close the interface, FFCustomInboundinterface
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3.2. Add Java component

In this part of the lab, you will add a Java component to the module and then wire the export to the added
component. Then you will add the custom Java code to the added module.

1. Open the assembly diagram for FFCustomInboundModule, if it is already not open

___a. From the business integration view, expand FFCustominboundModule and double click
Assembly diagram

2. Drop a Java component to onto the assembly diagram
___a. From the Palette, click Components to expand it

___b. Click Java and then click the empty space of FFCustomInboundModule assembly diagram. This
will place a new component, Componentl on the assembly diagram.

3.  Wire the FFCustomInboundIinterface to the Componentl

___a. Select the wire (CL:') icon from the Palette
___b. Click FFCustomInboundinterface and then click Componentl to wire them together
___C. Select OK for the Add Wire pop-up window:

4= Add Wire |

D] This ackion will allow the target service to be used in other modules, The
\:I/J service interface from the export will be added to the target. Do wou want ko
conkinue?

™ Always create without prompt

Cancel |

Your assembly diagram for FFCustomInboundModule will look like this:

e =5
=] *FFCustomInboundModule - Assembly Diagram 22

T

4 .2 Palette D 3 6
[% "!"";;-L ﬂ . - - .
o 2 - IJ'r.\
= Favarites ‘L % FrcustomInboundinterface lzl_]’ e Companent
.- % L] L ]

[ == Components

___d. From the top of the Palette, click the Selection Tool icon ( [%) to get back to the normal cursor
mode

4. Generate Java Implementation
___a. Right-click Componentl and select Generate Implementation from the pop-up menu

__b. On the Generate Implementation panel, select default package, and click OK
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___c. Componentlimpl.java is opened in Assembly editor. Scroll down to the method
emitCustomerFile(DataObject emitCustomerFilelnput) that needs to be implemented and
add this code under that method:

System.out .printhn(‘'****xxxxixxiXENDPOINT emitCustomerxaxiriktirirty ;
DataObject wrapper =
emitCustomerFilelnput.getDataObject(*'CustomerWrapper™);
String Filename = wrapper.getString("fileName'™);
System.out .printIn(""FILENAME : "+Filename);

DataObject customer = wrapper.getDataObject('Content');
String name = customer.getString(‘'customerName™);
System.out .printIn(""NAME----- > “+name);

String address = customer.getString('Address™);
System.out .printIn("'ADDRESS--> "'+address);

String city = customer.getString('City");

System.out .printIn("CITY-—-—- > "+city);

String state = customer.getString('State™);

System.out .printIn(""'STATE----> "+state);

Note: The code is also available at <FFFILES>\CustomerJavaCode.txt for your convenience

___d. Scroll down to the method emitOrderFile(DataObject emitOrderFilelnput) and add this code:

System.out . printhn(‘'****xxkxixxixENDPOINT emitOrder sxtihktirkrry -
System.out .printIn(""FILENAME :
“"+emitOrderFilelnput.getString( ' fileName'™));

DataObject order = emitOrderFilelnput.getDataObject(*'Content');
String OrderNumber = order.getString(*'OrderNumber');

System.out .printIn("'ORDER NUMBER----- > "+0rderNumber) ;

String OrderType = order.getString("'OrderType™);

System.out -printIn("'ORDER TYPE--> "+OrderType);

String Quantity = order.getString("'Quantity');

System.out -printIn(""QUANTITY----- > "+Quantity);

String Price = order.getString('Price™);

System.out .printIn(""PRICE----> "+Price);

Note: The code is also available at <FFFILES>\OrderJavaCode.txt for your convenience

___e. Save (Ctrl + S) and close Componentlimpl.java

5. Save (Ctrl + S) and close Assembly diagram: FFCustomIinboundModule
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3.3. Test non pass through scenario

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the non pass through Scenario with input file having a single business
object.

1. Add the project to the WebSphere Test Environment server

a. Right-click WebSphere Process Server v6.2 under the Servers view and select Add and
remove projects... from the pop-up menu

b. From the Add and Remove Projects window, select FFCustominboundModuleApp under
Available projects panel and click Add >

c. You will now see the FFCustominboundModuleApp added to the Configured projects

d. Click Finish and wait until the project is being published onto the server. The server will start in
Debug mode if it is not already started before

2. Putthe input files in the event directory

Note: For your convenience, the test files SingleCustomerBO.xml, SingleOrderBO.xml are placed in
<FFFILES>.

___a. Copy the SingleCustomerBO.xml file from <FFFILES> to <EVENT_DIR>. The adapter will poll
the copied xml file from the event directory and will transform it to the archive directory

___b. Check your Server Logs view (or Systemout.log file) for this successful message:

(-L'L:J Build Ackivities (E Propetties ﬂg_ Problems Server Logs &3 7k SErversT E‘a Aszet Repnsitnries} =B
B % B 00 o268~

Welcome WebSphere Process Server w6.2 at localhost 23 ]

Console (filtered): WebSphere Process Server vb 2 at localhost

Show All Record Types (Hierarchical) = with only Server State and Error Contents (Page 2 of 2)

Type | +  Time | Thread ID | Conkents
O = Log message Dec 15, 2008 14:35:34,734 00000077 WEYROZZ11: Application skarted: FFCustomInboundModulespp

B B Logmessage Diec 15, 2008 14:3 ] 00000020 Atk ENDPOINT emibCustomer sttt
D = Log message Dec 15, 2005 14:35:11.2581 O0ooaosg FILEMAME : SingleCustomerBo, xml

D = Log message Dec 15, 2008 14:538:11.2581 aooaooaa MAME----- = IBM

D = Log message Dec 15, 2008 14:535:11.281 aonoooaa ADDRESS--= 11501 Burnet Rd

D = Log message Dec 15, 2003 14:358:11.281 ulnllnulnj=l] CITY----- = Auskin

D = Log message Dec 15, 2003 14:38:11.281 ulnlulnulnj=ln] STATE----2 Tk

___¢. Now copy the SingleOrderBO.xml file from <FFFILES> to <EVENT_DIR>. The adapter will poll
the copied xml file from the event directory and will transform it to the archive directory
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___d. Check your Server Logs view (or SystemOut.log) for this message:

Tvpe | «  Time | Thread ID | ontents
O Log message Dec 15, 2003 14:35:34.734 Q0000077 WSYRO2211: Application started: FRCustomInboundModuledpp
O Log message Dec 15, 2003 14:33:11.281 00000090 wskk kR E L DPOINT emibCustomeyFAtskekkssobd
D = Log message Dec 15, 2008 14:358:11,281 Oao0o0s0 FILEMAME : SingleCustomerBo, xml
D = Log message Dec 15, 2008 14:358:11,281 Oao0o0s0 MAME----- = IEM
D = Log message Dec 15, 2008 14:358:11,281 Oao0o0s0 ADDRESS--= 11501 Burnet Rd
D = Log message Dec 15, 2008 14:358:11,281 Oao0o0s0

D E Log message Dec 15, 2008 14:38:11, Qao0o0s0

BB Logm , 2008 14:40:26,9¢

D E Log message Dec 15, 2008 14:40:26,953 Qao0o0s0 FILEMAME : SingleOrderBd. xml
O [5) Log message Dec 15, 2005 14:40: 26,953 Qoa0oos0 CRDER MUMBER----- = ABC12345
O [5) Log message Dec 15, 2005 14:40: 26,953 Qoa0oos0 DRDER THPE--= BLLE

O [5) Log message Dec 15, 2005 14:40: 26,953 oanoos0 QUAMNTITY----- =500

O [5) Log message Dec 15, 2005 14:40: 26,953 oanoos0 PRICE----= 265,59

3. You can also verify the results by reviewing the archive directory

___a. Check the <ARCHIVE_DIR> subdirectory which should contain two archives of the event files,
with the same file name appended with year, month, date, system time, and success

4. Restore the Sever Configuration

___a. Right-click WebSphere Process Server v6.2 under the Servers view and select Add and
remove projects... from the pop-up menu

___b. Select FFCustomIinboundModuleApp under Configured projects and click < Remove

___¢. Click Finish after you see the application moved to Available projects. Wait until the application
is being unpublished
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3.4. Test non-pass through scenario with SplitByDelimiter

In this last part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the non pass through Scenario with input file having multiple business
objects separated by a delimiter.

1. Configure/change the adapter properties from the Properties view:
___a. Change to Business Integration perspective if you are in a different perspective
1) Select Window > Open Perspective > Other...
2) From the Select Perspective window, select Business Integration (default) and click OK

___b. Expand FFCustominboundModule and double-click FFCustominboundModule to open it in
Assembly Editor

___c. Click FFCustomInboundinterface from the Assembly Editor and select Properties tab from the
bottom

__d. Select Binding under Properties and select End-point configuration under Binding itself and
then select the Connection

___e. Now click Advanced>> button at the bottom. You can see all the properties that were given
during the external service wizard

___f. Scroll down to Advanced Properties part and enter these:
1) Select the box for ‘Split file content based on size (bytes) or delimiter

2) Split function class name: com.ibm.j2ca.utils.filesplit.SplitByDelimiter (you can
Browse... and select)

3) Specify criteria to split file content: #####

File swstem connection infarmation

Event direckary: :iLabfilesa2\FlatFile Inbound! gventdir

Iﬁ.dvanced F‘ru:upertiesl

Retriava files with paftarn.: o

[ Faze oniv file name and directory, not the conéent
O fmciugte puminess obfact aalinter i e e confent

Refrigve fler in sorfed ordar, Mo sork IE'

Aife confent encading: UTF-&

Spacfy Hhe sodfing function oase name and Ehe soff crtara fo solt fhe fle canfend
I Spit Aie confend hazed on size (byfes) ar delimitar I

Spit Funchion class namea. com.ibrm.jZca, utils, Filesplit, SplitByDelimiter afff— Erowse, .,

Spaciy crtera fo ol fle confant. R AR f—
O Foif subdiractarias in event dreckory
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___g. Click Assembly diagram (or any where else so that the save button is enabled) and then save
(Ctrl +S) your changes
2. Repeat Step 1 of part 3.3 to add the saved project FFCustomInboundModuleApp to the server

3. Test the input file CustomerSplitByDelimiter.xml

Note: For your convenience, a test file CustomerSplitByDelimiter.xml is placed in <FFFILES>. The file
contains two Customer Business Objects separated by the delimiter ######.

___a. Copy the CustomerSplitByDelimiter.xml file from <FFFILES> to <EVENT_DIR>. The adapter
will poll the copied xml file from the event directory and will transform it to the archive directory

___b. Verify your results

1) Check your Server Logs view (or Systemout.log file) for this successful message:

Note: You will see the successful event delivery message twice as there were two Business Objects
present in the event file separated by the delimiter #####.

B B Logmessags Dec 15, 3 14:51; Hbddkdkdk bk N DPOINT emibCustomer etttk
O = Log message Dec 15, 2003 14:51:24,465 0o000ba FILEMAME ; CustamerSplitEyDelimiter, xml

D |=' Log message Dec 15, 2005 14:51:24. 465 00000ba MAME----- = IBM

D |=' Log message Dec 15, 2005 14:51:24. 465 00000ba ADDRESS--=> 11501 Burnet Rd

D |=' Log message Dec 15, 2005 14:51:24. 465 00000ba CITY----- = Buskin

D |=' Log message Dec 15, 20058 14:51:24.465 0oo00obEa STATE----= TX

O = Log message Dec 15, 2003 14:51:24.625 000000ba Ak kR E N DPOINT emibCushomey stttk
O = Log message Dec 15, 2003 14:51:24.625 00o000ba FILEMAME : CustornerSplitEyDelimiter . xml

|:| |=' Log message Dec 15, 2005 14:51:24.625 00000ba MAME----- = MBI

D |=' Log message Dec 15, 2005 14:51:24.625 00000ba ADODRESS--= RTP

O = Lag message Dec 15, 2003 14:51:24,625 00000ba ZITY-----= Raleigh

O = Log message Dec 15, 2005 14:51:24.625 Qoon0oba STATE----= NC

2) Check your <ARCHIVE_DIR> which should contain an archive of the event file, with the
same file name appended with year, month, date, system time, and success

MName

m SingleCustomerB0. xml, 2007_10_10_22 00_43_212.success

m SingleCrderB0. xml, 2007_10_10_22 02_29_185.success
CustomerSplitByDelimiter, xml, 2007_10_10_22 15 53 762.success

4. Test the input file OrderSplitByDelimiter.xml:

Note: For your convenience, the test file OrderSplitByDelimiter.xml is placed in <FFFILES>. The file
contains two Order Business Objects separated by the delimiter ####.

___a. Copy the OrderSplitByDelimiter.xml file from <FFFILES> to <EVENT_DIR>. The adapter will
poll the copied xml file from the event directory and will transform it to the archive directory

___b. Verify the results for OrderSplitByDelimiter.xml file:

1) Check your Server Logs view (or Systemout.log file) for this successful message:
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Note: You will see the successful event delivery message twice as there were two Business Objects

present in the event file separated by the delimiter #####.

B B Log message

Dec 15, 2005 14:52:

14.203

ER e s R E r.l ] D F. I:I I r.l ] T Em | t I:I I d et PR SR EE T

O = Log message
O = Log message
O = Log message
O = Log message
O = Log message
OE Log message
O = Log message
O = Log message
O = Log message
O = Log message
O = Log message

Dec 15, 2005 14:52:
Dec 15, 2005 14:52:
Dec 15, 2005 14:5:2:
Dec 15, 2005 14:5:2:
Dec 15, 2005 14:52:
Dec 15, 2005 14:52:
Dec 15, 2008 14:52:
Dec 15, 2005 14:52:
Dec 15, 2005 14:52:
Dec 15, 2005 14:52:
Dec 15, 2005 14:52:

14,203
14,203
14,203
14,203
14,203
14,251
14,2581
14,251
14,251
14,251
14,281

0000000E
0000000E
000000bs
0000000E
0000000E
a0o0oo90
Q0o0ao90
Q0o0ao90
Q0o0ao90
lalnlunj=ln]
Q0000030

FILEMAME : OrderSplitEyDelimiter . xoml
ORDER MUMEER.----- = ABC12345
CORDER TYPE--= BULE

QUANTITY----- =500

PRICE---- 26,59

FILEMAME : OrdersplitEyDelimiter, xml
ORDER MUMEER.----- = ENZ987
ORDER TYPE--= SIMGLE

CQUAMNTITY ----- = 1000

PRICE----= 56,67

2) Check your <ARCHIVE_DIR> which should contain an archive of the event file, with the

Mame

same file name appended with year, month, date, system time, and success

m SingleCustomerB0. xml, 2007_10_10_22 00_43_212.success
|_ﬂ SingleCQrderB0. xml, 2007_10_10_22 02_29_185,5uccess
|_ﬂ CustomersplitByDelimiter xml, 2007_10_10_22_15_53_762.success

5. Restore the Sever Configuration

OrderSplitByDelimiter, xml. 2007 _10_1

22 23 13 564.success

___a. Right-click WebSphere Process Server v6.2 under the Servers view and select Add and
remove projects... from the pop-up menu

___b. Select FFCustomIinboundModuleApp under Configured projects and click < Remove

___c. Click Finish after you see the application moved to Available projects. Wait until the application
is being unpublished

2009 February, 18

IBM WebSphere Adapter 6.2 — Lab exercise

Page 54 of 75

WBPMv62_AdapterFFIinboundLab.doc



© Copyright IBM Corporation 2009. All rights reserved

IBM WEBSPHERE ADAPTER 6.2 — LAB EXERCISE

Part 4: Use default function selector and data binding

This part of the lab will show you how to use the default use the default function selector and data binding
options from the External Service wizard and generate other required artifacts.

When you use the default function selector, you cannot define the rules as you did in Part 2 and hence
there will only be one method that handles all types of files.

When you use the default data binding, you cannot have multiple data types as in Part 3 and each data
type is handled by different method. Instead, there will only be one method and one data type.

After running the External Service wizard, you will add the required Java component with implementation
and then will continue to test the adapter.
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4.1. Configure inbound using default function selector and data
binding

In this part of the lab you will use the default function selector and data binding options from the External
Service wizard and generate other required artifacts to test the inbound scenario.

1. Create FFDefaultsinboundModule
___a. From the Business Integration window, right-click and select New > Module
___b. From the New Module window, enter FFDefaultsinboundModule for the Module Name
___c. Ensure that the box next to Open module assembly diagram is checked and then click Finish

You will now see a new module, FFDefaultsinboundModule, created from your Business Integration
window

2. To start External Service from the Palette:
___a. From the Palette on the left side of Assembly Diagram, click Inbound Adapters:

___b. Under Inbound Adapters, click the Flat File and then click the empty canvas of the assembly
diagram. The New Flat File Service wizard is opened

3. From the Flat File Service screen, select Create a service (advanced)

= Mew Flat File Service [ ]
Flat File Service
..F
Create a new flat file service,
[ Py

" Create a service from a pattern (bypical)

Filter: | type filker text

Available Patterns

= @" Adapters
El-[Z] Flat File

------ g—' Create an inbound Flak File service to read From a local File

___a. Click Next

Note: You can also start the External Service from the File menu option:

From the main menu, select File > New > External Service. This opens an External Service wizard that
helps you obtain a service which establishes connectivity with other systems.

Select Adapters > Flat File and click Next.
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4. On the Select an Adapter screen, expand IBM WebSphere Adapter for Flat Files (IBM : 6.2.0.0)
and select CWYFF_FlatFile

___a. Click Next
5. Service Configuration Properties:

___a. Deploy connector project: ensure that the default option With module for use by single
application is selected

___b. Under Connection Configuration, click Browse... next to Event directory and select
<EVENT_DIR> from the pop-up window:

4= External Service

Service Confiquration Properties

For this service, specify security and connection configuration properties,

Deploy connectar project: IWith module For use by single application -‘—j

Conneckion properties: ILIse properties below j

Conneckion properties

File system connection information

Event directary | Z:1Labfilesc2iFlatFileInboundieventdic

___¢. Click Advanced >> to see the hidden advanced properties that can be configured:

You can click each of the configuration and review the options available under it. This lab guides you
through some of the important and required configurations.

___d. Event persistence configuration: In this part of the lab, you will not use any JNDI instead use
adapter’s in-memory representation of event table to store all the necessary information

Note: The Event recovery data source (JNDI) name is not mandatory from V6.1. Now, the adapter can
use in-memory representation of event table to store all the necessary information. Adapter uses this
feature when event database information is not configured during inbound event polling. This feature will
not support the capability of handling “Ensure once-only event delivery”.
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___e. File archiving configuration:

1) Archive directory: click Browse... and select <ARCHIVE_DIR>

r
* File archiving configuration

Specify archive directory to archive processed inbound event files

Archive direckory; | C:1Labfiless2FlatFileInboundtarchivedir (_[M

File extension For archive: I original

Success file extension For archive: | SUCCESS

Failure file extension For archive: I Fail

6. Under Service properties, for Function selector options, select Use default function selector
‘FilenameFunctionSelector’ from the drop down list

7. For Data format options, select Use default data binding ‘FlatFileBaseDataBinding’ for all
operations from the drop down list

Service propetties

Funckion selector apkions: ILIse default Function seleckar ‘FilenameFunchionSeleckar’ "_j

Function selectar; Mot defined Select, .,

Data Farmat opkions: ILIse default data Farmat 'FlatFileBaseDataBinding' Far all n:nperatin:nns‘-j

[ata Format; Mot defined Select, .,

8. Check the box next to Change logging properties for wizard to view the output location of the log
file and the logging level and click Next

Define emitFlatFileBG operation:
9. From the Operations screen, click Add...

___a. Add Operation window is opened. Select Generic FlatFile business object with business
graph for the Data type and click Next

Operation properties

Data type for the operation:

You are back to Operation window and because you have chosen the data type with business graph,
the Input type is populated as FlatFileBG.

10. For Operation name, enter any name, for Ex: emitFlatFileBG
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11. Accept the default selection, Use suggested data format ‘FlatFileBaseDataBinding’, for Data
format options

+4= Add Dperation [_ O]
Operation
Specify the properties For the operation to add., ‘\‘FI:I i
s |

Operation name: * I emitFlatFileBa I

Specify the operation input

Inpuk Evpe: IFIatFiIeBG {httpe v ibrn, comxmins/prodfwebspherejzealfl  Browse, .. | e, .. |

Data Formak opkions: ILIse suggested data Farmat 'FlatFileBaseDataBinding' -‘—j

[ata format: Mak defined Seleck, . |

___a. Click Finish. The above defined operation, emitFlatFileBG, is populated under Operations list

Operations:
------ emitFlatFileBG ({hittp:/fwww.ibm.comfxmins/prod/websphere fi2ca ffatfile fatfilebg}FlatFileBE) @ void

| Edit... |

___b. Click Next from Operations screen

12. From Generate Service screen, accept the default value, FlatFileExport, for Name

Properties Faor service

Madule: IFFDeFauItsInhDundMDdule j eEw, .. |

Mamespace; |http:,I',I'FFDeFauItsInI:u:uundMu:uduIe,l'FIatFiIeExpu:urt

¥ Use default namespace

Mame: # | FlatFileE xport

Descripion: I |

___a. Click Finish

13. The Assembly diagram for FFDefaultsinboundModule is opened with an Export component,
FlatFileExport:

‘7:'& *EFDefaultsInboundMadule - Assembly Diagram &3
¢ nr Palette
% '~i’{'~é{c-|-j # s ® .
[~ Favorites ® @ FlatFileExport
[ ]

14. Save (Ctrl + S) changes to your assembly diagram

2009 February, 18 IBM WebSphere Adapter 6.2 — Lab exercise Page 59 of 75

WBPMv62_AdapterFFIinboundLab.doc



© Copyright IBM Corporation 2009. All rights reserved

IBM WEBSPHERE ADAPTER 6.2 — LAB EXERCISE

4.2. Add Java component

In this part of the lab, you will add a Java component and then wire the component to the existing Export
interface. The Java component is your endpoint.
1. Open the assembly diagram for FFDefaultsinboundModule (if it is already not open)

___a. From the business integration view, expand FFDefaultsinboundModule and double click
Assembly diagram

2. Drop a Java component to onto the assembly diagram
___a. From the Palette, click Components to expand it

___b. Click Java and then click the empty space of FFDefaultsinboundModule assembly diagram. This
will place a new component, Componentl on the assembly diagram.

3. Wire the FFDefaultsinboundinterface to the Componentl

a. Select the wire (CL:') icon from the Palette
b. Click FlatFileExport and then click Component1 to wire them together

c. Select OK for the Add Wire pop-up window:

d. From the top of the Palette, click the Selection Tool icon ( [‘}) to get back to the normal cursor
mode

e. Right-click the empty space of the Assembly diagram and select Arrange Contents
Automatically from the pop-up menu

Your assembly diagram for FFDefaultsinboundModule will look like this:

=)
':i::' '?J FlatFileExpart % i Component

___f. Right-click Componentl and select Generate Implementation from the pop-up menu
___g. On the Generate Implementation panel, select default package, and click OK

__h. Componentlimpl.java is opened in Assembly editor. Scroll down to the method emitFlatFileBG
that needs to be implemented and add this code under that method:

System.out .printIn("***********Reached Endpointx*****xkxtixry -
___i. Save (Ctrl + S) and close Componentlimpl.java

__j. Save (Ctrl + S) and close Assembly diagram: FFDefaultsinboundModule
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4.3. Test all defaults scenario

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the pass through scenario.

1. Add the project to the WebSphere Test Environment server

a. Right-click WebSphere Process Server v6.2 under the Servers view and select Add and
remove projects... from the pop-up menu

b. From the Add and Remove Projects window, select FFDefaultsinboundModuleApp under
Available projects panel and click Add >

c. You will now see the FFDefaultsInboundModuleApp added to the Configured projects

d. Click Finish and wait until the project is being published onto the server. The server will start in
Debug mode if it is not already started before

2. Test the application by providing three different input files:

Note: For your convenience, three test files, sample.txt, sample.txtl, sample.txt2 are placed in
<FFFILES>.

___a. Copy the any of the three test files (for Ex: sample.txt file) from <FFFILES> to <EVENT_DIR>.
The adapter will poll the copied file from the event directory and will transfer it to the archive
directory

__b. No matter what type of file you put in Event directory, it will pass through the only existing
method, FlatFileBG, and you should see this message your Server Logs view (or
SystemOut.log):

B B Log message Dec 15, 2008 15:04:23.953 B T T L e ——

___c. To verify your test results, check the <ARCHIVE_DIR> subdirectory which should contain an
archive of the event file, with the same file name appended with year, month, date, system time,
and success

MName

Jfsample. tet, 2007_10_10_17_53 57 913.success

3. Restore the Sever Configuration

___a. Right-click WebSphere Process Server v6.2 under the Servers view and select Add and
remove projects... from the pop-up menu

__b. Select FFDefaultsInboundModuleApp under Configured projects and click < Remove

___c. Click Finish after you see the application moved to Available projects. Wait until the application
is being unpublished
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Part 5: Use ‘Create a service from a typical pattern’

In this part of the lab you will use the typical pattern option from the External Service wizard to create and
configure the Function Selector, Data Binding and other required artifacts to test the inbound scenario.

Based on your selection, the Binding resources (data binding and function selector) are created which you
will review later in this part.

After running the External Service wizard, you will continue to add the Java component with
implementation and then test the adapter.
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5.1. Configure inbound using ‘Create a service from a pattern
(typical)’ option

In this part of the lab you will use the typical pattern from the External Service feature to create and
configure the Function Selector

1. Create the module: FFTypicallnboundModule
___a. From the Business Integration window, right-click and select New > Module
___b. From the New Module window, enter FFTypicallnboundModule for the Module Name
___c. Ensure that the box next to Open module assembly diagram is checked and then click Finish

You will now see a new module, FFTypicallnboundModule, created from your Business Integration
window and the Assembly diagram for the same module is opened in the Assembly Editor.

2. Import required business objects

___a. Expand FFTypicallnboundModule (if not already expanded), right-click Data Types and select
Import... from the pop-up menu

___b. From the Import window, expand General and select File System and then click Next
___c. Enter From directory

1) Click Browse... next to From directory

2) From the Import from directory window, select <FFFILES > and click OK

Now, you will see FFFiles folder added on the left side, and all the xsds and files under that folder on
the right side.

___d. Select the box next to Customer.xsd
___e. Ensure that the FFTypicallnboundModule is selected for Into folder
__f. Click Finish from the Import window
The Business Integration window is updated with the imported business objects.
3. Review imported business object:

___a. Expand FFTypicallnboundModule > Data Types and you will now see a new data type
Customer and Order under it.
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___b. Double-click Customer review the fields inside the object:

- q
[ Customer

[8] customerMame string

[8] Address string
[8] City string
[8] 5tate string

| I -'";-:E]I

___c. After reviewing, close the Customer business object from the Assembly editor

4. To start External Service from the Palette:

___a. From the Palette on the left side of Assembly Diagram, click Inbound Adapters:

. Under Inbound Adapters, click the Flat File and then click the empty canvas of the assembly
diagram. The New Flat File Service wizard is opened

. From the Flat File Service screen, accept the default selection of Create a service from a pattern
(typical)

4= New Flat File Service

Flat File Service

J w0
Create a new flat file service,
Exm

[G iCreate a service from a pattern l{t‘;.-’piu:al]lé] " Create a service {advanced)

Available Patkerns:

= L_'é, Integration
El---@" Adapters
=2 Flat File
E—' Create an inbound Flat File service ko read From a local file

Descripbion:

The Flat File inbound pattern creates a service that retrieves a file from a directory on the local file syskem,
If the file is nok in an =ML Format, wou can specify a data handler that will transform From the File content

format to business objects, The file content can be split if the conkent contains multiple copies of the data
structure For processing.

=

___a. Click Next
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7. From this Flat File service name screen, for Name, accept the default value ‘FlatFileExport’ and
click Next
4= New Inbound Flat File Service
Flat File service name ol
Specify the name and location of the inbound Flak File service, p P
(S
Module: IFFT';.-'piu:aIInI:u:uunu:IM-:udule j Browse, ., | [T

Mamespace; Ihttp:,I',I'FFT‘:.-'|:IiI:a|II'||:lDLII‘ldMEIdLI|E,I'F|EItFi|EE}(|:IDrt v Default

Folder; | Browse, .. |

Mame:! | FlatFileExport]

(7 < Back I Mexk = I Eimish Cancel

8. From the Business object and directory screen, enter these:

___a. Click Browse... next to Business object and a Data Type Selection window is opened

___b. Select Customer under Matching data types and click OK

Filter by tvpe, namespace, or file (¥ = any character, * = any String):
E Mew, .,
Makching data bypes:
[l

___¢. Now, click Browse... next to Directory and a Browse For Folder window is opened
___d. From this window, navigate to select <EVENT_DIR> and click OK

___e. Your Business object and directory screen should look like this:

YWhat business object do you want to read from the input file?

Business object: ICustDmer {hiktpe f e, ibrn, compxminsfprodfwebsy - Browse. ., |

What directory should be polled fFor the input file?

Direckory: I :iLabfiles62\FlatFileInboundieventdir

___f. Click Next
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9. From the Input file format and file content split option screen, enter these:
___a. For input file format, accept the default XML selection

___b. For file content split option, accept the default selection, None

= New Inbound Flat File Service E
Input file format and file content split option al
Specify the input file Format and the file content split option. ——

e

What is the input file formak?

" Dther

Specity a data handler bo transfiorm the native data Format to a business abject,

[Data handler: | Browse, ., |

Which file content split option do you want to use?

" Split file content by fixed size

Sige (in bytes); |
{” Split file content by delimiter

Lelimiter: I

i~ split file content using a custom splitter

Cuskom splitter: | Erowse,.. |

Split: criteria I

(7] < Back i Mext =

Einish I Zancel

___C. Click Next

10. From the Archive directory and wrapper business object screen, enter these:

___a. Click Browse... next to Local archive directory and select <ARCHIVE_DIR>
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___b. Check the box next to Use a wrapper business object to contain additional input file
information. This will generate a Customer Wrapper under the Data Types of your Module

% New Inbound Flat File Service
Archive directory and wrapper business object o=
Specify the archive directory and option For providing additional input: file information, 1

(S

¥Where do you want to archive the incoming input file?

Optionally specify a local archive directory For processed files. The File extension will indicate if the File was
successfully processed,

Local archive directory: | C:iLabfiles62)FlatFileInboundarchivedir (—lw

___C. Click Finish

11. Save (Ctrl + S) changes to your assembly diagram

"-Bl FFTypicallnboundModule - Assembly Diagram &3
¢ e Palette
[y L= 51 )
[== Favarites 'E' ?J FlatFileExport

____12. Review the FFTypicallnboundModule and the generated artifacts: The generated Data Types,
Interface, Data handler (UTF8XMLDataHandler) and Data binding (FlatFileXMLDataBinding)
under Configured Resources can be found under FFTypicallnboundModule. You can open each of
these generated artifacts, business objects and review the properties inside.

Ellg FFTypicalinboundradule
=175 Assembly Diagram

FlatFileExpaork

----- o Dependencies

..... = Integration Logic
E":F” Diata Tyoes
(] Customer
l'j Cuskomerhrapper
|;:|.--'§' Interfaces

(A [FatFietaport |
..... &1 Mapping
=--iiz Binding Resource

B-&

[ FlatFilexMLDataBinding

e, UTFERMLD ataHandler
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5.2. Add Java component

In this part of the lab, you will add a Java component and then wire the component to the existing Export
interface. The Java component is your endpoint.

1. Open the assembly diagram for FFTypicallnboundModule (if it is already not open)

___a. From the business integration view, expand FFTypicallnboundModule and double click
Assembly diagram

2. Drop a Java component to onto the assembly diagram
___a. From the Palette, click Components to expand it

___b. Click Java and then click the empty space of FFTypicallnboundModule assembly diagram. This
will place a new component, Componentl on the assembly diagram.

3. Wire the FlatFileExport to the Componentl

a. Select the wire (CL:') icon from the Palette
b. Click FlatFileExport and then click Component1 to wire them together

c. Select OK for the Add Wire pop-up window:

d. From the top of the Palette, click the Selection Tool icon ( [‘}) to get back to the normal cursor
mode

e. Right-click the empty space of the Assembly diagram and select Arrange Contents
Automatically from the pop-up menu

Your assembly diagram for FFTypicallnboundModule will look like this:

o

@ 2 FlatFileExport (@) 152 Companent1

___f. Right-click Componentl and select Generate Implementation from the pop-up menu
___g. On the Generate Implementation panel, select default package, and click OK

___h. Componentlimpl.java is opened in Assembly editor. Scroll down to the method emitCustomer
that needs to be implemented and add this code under that method:

System.out -println(rxxsrxxtrxx ENDPOINT
System.out .printIn("'FILENAME :
"+emitCustomerinput.getString("'fileName'™));
DataObject customer = emitCustomerlnput.getDataObject(''Content');
String name = customer.getString(‘‘customerName');
System.out -printIn("'NAME----- > "+name);

String address = customer.getString('Address™);
System.out .printIn(""ADDRESS--> "+address);

String city = customer.getString('City™);
System.out .printIn(C"CITY-——-- > "+city);

String state = customer.getString(‘'State');
System.out .printIn("'STATE----> "+state);
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Note: The code is also available at <FFFILES>\TypicalCustomerJavaCode.txt for your convenience

___i. Save (Ctrl + S) and close Componentlimpl.java

___j. Save (Ctrl + S) and close Assembly diagram: FFTypicallnboundModule
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5.3. Test typical pattern scenario

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the typical pattern with input file having single business object.

1. Add the project to the WebSphere Test Environment server

a. Right-click WebSphere Process Server v6.2 under the Servers view and select Add and
remove projects... from the pop-up menu

b. From the Add and Remove Projects window, select FFTypicallnboundModuleApp under
Available projects panel and click Add >

c. You will now see the FFTypicallnboundModuleApp added to the Configured projects

d. Click Finish and wait until the project is being published onto the server. The server will start in
Debug mode if it is not already started before

2. Putthe input files in the event directory

Note: For your convenience, the test file SingleCustomerBO.xml is placed in <FFFILES>.

___a. Copy the SingleCustomerBO.xml file from <FFFILES> to <EVENT_DIR>. The adapter will poll
the copied xml file from the event directory and will transform it to the archive directory

___b. Check your Server Logs view (or Systemout.log file) for this successful message:

B B Logmessage Dec 15, 2005 15:14:54.343 Aebsbekkeksk kb ENDPOINT emibiCuskomey ks
O = Log message Dec 15, 2003 15:14:54.343 000000be FILEMAME : SingleCustomerBo, xml

D |=' Log message Dec 15, 2005 15:14:54, 343 000000be MAME----- = IBM

D |=' Log message Dec 15, 2005 15:14:54, 343 000000be ADDRESS--= 11501 Burnet Rd

D |=' Log message Dec 15, 2005 15:14:54, 343 000000be CITY----- = Buskin

D_ |=' Log message Dec 15, 2005 15:14:54, 343 000000be STATE----=Tx

3. You can also verify the results by reviewing the archive directory

___a. Check the <ARCHIVE_DIR> subdirectory which should contain one archive of the event file, with
the same file name appended with year, month, date, system time, and success

Address IC] 1L abfiless 14 FlatFileInbound) archivedic

| Size | Tvpe | Date Modified |_attributes |
1KE SUCCESS File 10/22/2007 G141 &M A

Folders X

=l ) Labfilese1 |

4. Restore the Sever Configuration

___a. Right-click WebSphere Process Server v6.2 under the Servers view and select Add and
remove projects... from the pop-up menu

___b. Select FFTypicalinboundModuleApp under Configured projects and click < Remove

___c. Click Finish after you see the application moved to Available projects. Wait until the application
is being unpublished
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What you did in this exercise

In this lab, you started with importing the Flat File Adapter RAR file into your WebSphere Integration
Developer new workspace. Next, you made use of the External Service wizard available in WebSphere
Integration Developer to specify Activation Spec Properties, define Data binding, Data handler, and
Function selector which, after deploying onto the server, will generate Business Objects and other

artifacts.

At the end of each part, you deployed and then tested the adapter application for these scenarios - pass-
through (with and without SplitBySize) test scenario, two content specific or non pass through (with and
without SplitByDelimiter) test scenarios, using all defaults (default data binding, function selector) scenario,
and then finally using the typical pattern.
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Task: Adding remote server to WebSphere Integration Developer test
environment

This task describes how to add a remote server to the WebSphere Integration Developer Test environment.
This example uses a z/OS machine.

1. Define a new remote server to WebSphere Integration Developer.
___a. Right click the background of the Servers view to access the pop-up menu.

___b. Select New - Server.

Euild Activities (E Properties ﬂ;_ Problems ( Server Logs ('5% Servers &4 @p Asset Repositories] 3& Q. m L | E" ==

Server Status

___c. Inthe New Server dialog, specify the remote server’s host name, <HOSTNAME>.

___d. Ensure that the appropriate server type, ‘WebSphere Process Server v6.2’ or ‘WebSphere
ESB Server v6.2', is highlighted in the server type list

&= New Server H[=]
Define a New Server E
Choose the bvpe of server to create

Server's host names: | mysxxx.rbp.raleigh.ibm, com

Dowenload additional server adapters

Select the server bype:

Itype filker text

webSphere Application Server wa.0 ﬂ
WwebSphere Application Server wa.1

‘Web3sphere Application Server «7.0

‘Web3Sphere ESE Server v6.2

WebSphere Portal +6.0 Server

.0 WebSphere Portal wb. 1 Server

WebSphere Portal w6, 1 Server on Was 7

=l
Runs service projects on the WebSphere Process Server vo, 2,
SErver Name: | WebSphere Process Server v6.2 at mesxxs, rbp.raleigh.ibm, com
Server runkime environmenk: IWebSphere Process Server v6,2 j Add...

Configure runtime environments. ..

'1:':’:1' = Back Mext = | Einish I Cancel

___e. Click Next.
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___f. On the WebSphere Server Settings page, leave the radio button for Manually provide
connection settings selected, and select the box for SOAP

___g. Enter the correct setting (<SOAP_PORT>) for Port column

__h. If security is enabled on your server, select the box for ‘Security is enabled on this server’ and
enter <USERID> for the user ID and <PASSWORD> for the password.

= New Server Mi=] E3
WebSphere Server Settings - g
Input settings for connecting to an existing WebSphere Application Server,
1
WebSphete profile manme: j Confiqure profiles. ..

Server connection types and administrative ports
| mubomatically, determine conneckion settings

* Manually provide connection settings

Conneckion Type | Port | Default port | Description |
[ rMI 2809 Designed ko improve communication with the server
v soar gaa0| ga80 Designed to be more Firewall compatible

[T Rum sepver with Fesources within the workspace
[v Security is enabled on this server

Current active authentication settings:

User [D; I ssadmin

Password: I LTTITTYY

Websphere server name: | serverl

Test Connection

() < Back Next | Firish I Cancel

___i. Click Finish.

___j. The new server should be seen in the Server view.

2 Build Activities (E Propetties ﬁz— Problems ( Server Logs ($?$ Servers &4 Pﬂ Asset Repositories} =0
I 0 e i
| state | status
[f= Starke Svnchronized

.raleigh.ibm, com 1 Synchronized

2. Start the remote server if it is not already started. WebSphere Integration Developer does not
support starting remote servers from the Server view.

___a. From a command prompt, telnet to the remote system if needed:
‘telnet <HOSTNAME> <TELNET_PORT>’
User ID : <USERID>

Password : <PASSWORD>
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___b. Navigate to the bin directory for the profile being used:
cd <WAS_HOME>/profiles/<PROFILE_NAME>/bin
___¢. Run the command file to start the server: ./startServer.sh <SERVER_NAME>

___d. Wait for status message indicating server has started:

ADMU32001: Server launched. Waiting for initialization status

ADMU30001: Server sssr0l1 open for e-business; process id iIs 0000012000000002
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